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1 Einleitung 

1.1    Motivation 
Die Richtlinie zur Erhaltung der wildlebenden Vogelarten der EU-Mitgliedstaaten 

(79/409/EWG), kurz Vogelschutzrichtlinie genannt, hat zum Ziel, auf die in Anhang 1 

aufgeführten Arten besondere Schutzmaßnahmen anzuwenden, um deren Überleben und 

Vermehrung im Verbreitungsgebiet langfristig sicherzustellen 

(WWW.UMWELT.STEIERMARK.AT/CMS/ZIEL/1566820/DE/#13). Hierzu zählt u.a. auch der 

Steinadler (Aquila chrysaetos). Momentan zählt dieser Greifvogel in den Alpen nicht zu den 

aktuell, sondern zu den potentiell gefährdeten Tierarten (BRENDEL et al. 2000). Sein Schutz ist 

trotzdem von großer Bedeutung, da dieser der Steinadler auf Grund seiner Lebensweise als 

Schlüsselart alpiner Ökosysteme beschrieben wird (BRENDEL et al. 2000). 

Mit einem Vorkommen von etwa 250 Steinadlerpaaren in den österreichischen Alpen 

(WWW.NATIONALPARK.CO.AT/NATIONALPARK/DE/NATURRAUM-TIERE-FELS-TEIN.PHP), kommt 

dem Land Österreich damit eine große Verantwortung im Schutz dieses Greifvogels zu.  In der 

Steiermark siedeln derzeit etwa  35 – 40 Adlerbrutpaare (SACKL & SAMWALD 1997).   

1.2    Fragestellung und Zielsetzung 
Die Durchführung dieser Arbeit erfolgt im Auftrag des Nationalparks Gesäuse in der Steiermark 

und richtet sich nach der Studie von HÖLSCHER 2005. Ziel ist es weitere Erkenntnisse bezüglich 

des Steinadlerlebensraums im Planungsgebiet des Nationalparks Gesäuse zu erlangen und einen 

Beitrag zur Beantwortung folgender Fragen zu leisten: 

 Wie sieht die naturräumliche Ausstattung anhand ausgewählter Faktoren im hochalpinen 

Nationalpark Gesäuse aus?  

 Welche Lebensbedingungen ergeben sich daraus für die jeweils dort angesiedelten 

Steinadlerpaare?  

 Von welcher Art und wo ist die bodengebundene, anthropogene Beeinflussung in dem 

Untersuchungsgebiet? 

Auf einem geographischen Ansatz basierend erfolgt für das Untersuchungsgebiet eine mit Hilfe 

des Geographischen Informationssystems (GIS) durchgeführte Analyse ausgewählter 

Umweltparameter. Für die qualitative Auswertung dieser Faktoren werden anschließend die 

Lebensraumansprüche des Steinadlers als Bewertungskriterium hinzugezogen. 
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2 Methodik 

2.1 Das Geographische Informationssystem (GIS) als Grundlage für die 
Ökosystemanalyse  

Eine großflächige Lebensraumanalyse, wie sie im Rahmen der vorliegenden Arbeit durchgeführt 

wird, ist mit Hilfe eines Geographischen Informationssystems (GIS) sehr gut möglich (vgl. 

HÖLSCHER 2005). Das GIS stellt ein geeignetes Werkzeug dar um die raumbezogene 

Ausprägung der Umweltverhältnisse in einem Untersuchungsgebiet – besonders eines 

großflächigen und unzugänglichen Gebietes - schnell zu erfassen. Die Stärke dieses Systems 

liegt in der einfachen Darstellung komplexer Sachverhalte und der Visualisierung der Ergebnisse 

in thematischen Karten. Darin liegt ein entscheidender Vorteil dieser Methode gegenüber der 

reinen Wertdarstellung der Daten, wie es durch einfache Berechnungen der Fall ist. Besonders 

effektiv hat sich das GIS auch im Vergleich verschiedener Lebensräume miteinander bewiesen. 

In diesem Fall steht die Gegenüberstellung der Steinadlerlebensräume des Planungsgebietes 

Nationalpark Gesäuse und der Region der Niederen Tauern in Planung. 

Die Berechnungsgrundlage dieser GIS-Analyse bilden Rasterformate. Sie eignen sich besonders 

zur Erfassung kontinuierlich verteilter Daten und für großflächige, räumliche Berechnungen 

(BILL & FRITSCH 1991) wie sie in der vorliegenden Arbeit durchgeführt wurden. 

2.2 Datengrundlagen 
Ein entscheidendes Kriterium für die Ergebnisqualität einer Lebensraumanalyse ist die 

Genauigkeit der Datengrundlage. Die Auflösung der Daten wie sie in dieser Arbeit verwendet 

werden (siehe weiter unten), ist vollkommen ausreichend um Grundaussagen über das Gebiet zu 

treffen. Dies gilt auch hinsichtlich der Lebensraumbeurteilung für den Steinadler. Ein Areal von 

10 m x 10 m nimmt im Vergleich zu der Größe des Aktionsradius des Adlers nur einen sehr 

kleinen Ausschnitt ein und wird auf Grund der Mobilität des Vogels leicht und schnell 

überflogen (vgl. HÖLSCHER 2005).  

Lediglich in Bezug auf die Analyse der Parameter „Neigung“ und „Potentielle Brutfelsen“ 

können sich geringfügige Abweichungen ergeben (vgl. HÖLSCHER 2005). Grund hierfür ist, dass 

bei Rasterdaten der Durchschnitt aller - innerhalb einer Rasterzelle - vorkommenden 

Parameterwerte gebildet und dieser zugeordnet wird. Je größer die Zelle, d.h. je größer der zu 

erfassende Raumausschnitt für den ein Durchschnittswert berechnet wird, desto höher ist die 

Wahrscheinlichkeit, dass Extremwerte nicht berücksichtigt werden. So werden z.B. bei oben 

genannten Parametern, sehr steile Hänge kaum erfasst und sind deutlich weniger verzeichnet, als 

sie tatsächlich vorhanden sind.  
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Bei der Analyse der Biotoptypen muss eine weitere geringfügige Abweichung beachtet werden. 

Die Biotoptypenklassifikation wurde von Luftbildern aus den Jahren 1997, 1998 und 1999 

abgeleitet. Da anzunehmen ist, dass es seither zu Veränderungen der Vegetationsstruktur 

gekommen ist, stimmt diese Biotoptypenverteilung nicht mehr mit der aktuellen Situation 

überein. Diese Tatsache bleibt bei den Analysen dieser Arbeit unberücksichtigt.  

Digitales Geländemodell (DGM)  

Das in dieser Arbeit verwendete Digitale Geländemodell des Bundesamts für Eich- und 

Vermessungswesen besitzt eine Rasterauflösung von 10 m x 10 m. Diese Abbildung des Reliefs 

mit den dazugehörigen Höheninformationen stellt die wesentliche Grundlage für alle flächenhaft 

durchgeführten Berechnungen dar. Daraus wurden die wesentlichen Habitatparameter wie 

„Exposition“, „Neigung“ und „Einstrahlsituation“ ermittelt. Alle Daten sind im 

Bundesmeldenetz (BMN), einer spezifischen Anwendung des Gauß-Krüger-Systems,  unter 

Verwendung des Erdellipsoides nach BESSEL dargestellt. Das Untersuchungsgebiet liegt im 

mittleren, der drei, in Österreich vorhandenen Meridianstreifen und bezieht sich somit auf den 

Zentralmeridian 31°. Alle zusätzlich benutzten digitalen Datengrundlagen besitzen ebenfalls 

diese Projektion. 

 Festlegen der Projektion: Öffnen der ArcToolbox > Data Management Tools > Define Projection > 

BMNM 31 

Luftbildklassifikation 

Die Luftbildinterpretation wurde von Infrarot-Luftbildern aus den Jahren 1997 und 1998 sowie 

Orthophotos aus den Jahren 1998 und 1999 abgeleitet. Sie wurden flächendeckend für das 

gesamte Planungsgebiet Nationalpark Gesäuse erstellt und besitzen eine Bodenauflösung von  

30 cm. Alle Datensätze sind Datengrundlage der Nationalpark Gesäuse GmbH.  

Weiteres Datenmaterial  

Darüber hinaus wurde für die Auswertung der GIS-Analysen die in digitaler Form vorliegende 

OEK 50 des Bundesamts für Eich- und Vermessungswesen und die aktuelle analoge 

Alpenvereinskarte „Ennstaler Alpen / Gesäuse“ im Maßstab 1: 25 000 des Österreichischen 

Alpenvereins verwendet. Hinzu kommen thematische Grundlagendaten zum räumlichen 

Vorkommen weiterer Tierarten oder zum Wanderwegenetz, die seit dem Jahre 2002 für das 

Gebiet des Nationalparks Gesäuse erhoben wurden. Diese sind in Form von Vektoren oder 

Rastern im GIS katalogisiert und stehen für Analysezwecke zur Verfügung.  
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2.3 Verwendete Habitatparameter 
Die Auswahl der Parameter basiert auf der von HÖLSCHER 2005 durchgeführten GIS-Analyse 

zweier Steinadlerlebensräume und in Anlehnung an die Parameter, die EBERHARDT (1996) im 

Rahmen einer Habitatmodellierung für einen hochalpinen Lebensraum verwendete. Die von 

EBERHARDT erarbeiteten Lebensraumansprüche des Steinadlers wurden zumeist durch 

Telemetrienachweise bestätigt.  

Anhand der Berechnungen nachfolgend aufgeführter abiotischer und biotischer Parameter lassen 

sich grundlegende Informationen über die naturräumliche Ausstattung des Planungsgebietes des 

Nationalparks Gesäuse erhalten. Auf Grund dieser Auswahl sind weiterführende Analysen und 

eine sinnvolle Naturraumbewertung bezüglich des Steinadlers möglich (vgl. HÖLSCHER 2005). Je 

mehr bei der Kombination der Parameter auf die Bedürfnisse des Tieres eingegangen wird, umso 

genauere Aussagen lassen sich über das Habitat treffen. 

 

Die Auswertung der Ergebnisse basiert auf dem Wissen, dass die Autorin über die Ökologie des 

Steinadlers und dessen Lebensraumansprüchen besitzt. Neben dem Expertenwissen, flossen 

entsprechende Fachliteratur (vgl. QUELLENVERZEICHNIS), bereits erhobene Daten für das 

Planungsgebiet und Interviews mit lokalen Experten (SCHREB 2005, ZECHNER 2005) in die 

Bewertung der Parameter mit ein.  

 

2.3.1 Abiotische Umweltfaktoren 

Die Berechnung folgender abiotischer Habitatparameter erfolgte im GIS unter Anwendung des 

Spatial Analyst und auf der Datengrundlage des Digitalen Geländemodells (DGM). Die 

Zellgröße der Analysen richtet sich nach dessen Genauigkeit (siehe Kapitel 2.2). Eine Ausnahme 

bildet die Erstellung des Parameters „Profil“, die mit Hilfe des 3-D-Analyst durchgeführt wurde. 

 Aktivieren des Spatial Analyst und 3D-Analyst: 

 Tools > Extensions > Spatial Analyst und 3D-Analyst anklicken 

Profil  

Mit der Funktion Interpolate Line wurde die Profilschnittlinie im DGM so festgelegt, dass sich 

daraus eine aussagekräftige Charakteristik des Untersuchungsgebiets ergibt (vgl. Abb.1 und 

Abb.2).  

 

 



2 Methodik 

 

8

Erstellen des Profilschnittes im GIS: 

 3D-Analyst > Button „Interpolate Line“ anklicken > Linie ziehen, die der Profilschnittlinie entsprechen 

soll >Button „Create Profil Graph“ anklicken > Profil wird erstellt 

 Änderungen der Profileigenschaften bzw. des Layouts: Mit re Maustaste auf Profil Graph Title (blauer 

Balken über Profil) > Properties > Advanced Options 

 

 

Gstatterboden

Enns

Profilschnittlinie
Grenze Planungsgebiet

±

 
Abb. 1: Profilschnitt 

     

Höhenverteilung 

Die digitale Geländeoberfläche wurde mit der Funktion Reclassify in Höhenklassen ả 100 m 

eingeteilt. Es erfolgt zudem eine Klassifikation in die Höhenstufen „submontan“ (400 m – 800 m 

ü.NN), „montan“ (801 m – 1.400 m ü. A), „subalpin“ (1.401 m – 1.800 m ü. A) und „alpin“ 

(1.801 m – 2.800 m ü. A) (vgl. ADLER et.al. 1994). 

Erstellen der Höhenklassifikation im GIS: 

 DGM laden 

 Spatial Analyst >Reclassify > Inputraster: DGM > Classify > unter „Classification“ 20 Klassen festlegen 

> unter „Break Values“ Höhenklassenzahlen eingeben (500, 600, 700…..) > ok > unter „Outputraster“ 

Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
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Expositionsverteilung 

Die Exposition wurde in 8 Klassen unterteilt (siehe Tab.1), wobei jeder Rasterzelle ein 

entsprechender Wert zugeordnet wurde. Bei einer Neigung von 0° (Flaches Gelände) konnte 

keine Hangausrichtung definiert werden; alle geneigten Flächen erhielten jedoch eine  

Zuweisung. Ihre Werte entsprechen der Richtung der Flächennormale in Grad, bezogen auf die 

Nordrichtung, welche mit 0° definiert ist.  

Erstellen der Expositionsklassifikation im GIS: 

 DGM laden 

 Spatial Analyst > Surface Analysis > Aspect (Input surface: DGM, Cellsize: 10, Outputraster: Bezeichnung 

festlegen) > ok  

 Spatial Analyst > Reclassify > Inputraster: berechnete Exposition; „New Values“ neu definieren („Old 

Values“ 0 – 22,5 und 337,5 – 360 müssen gleiche „New Values“, d.h. die gleiche Zahl, besitzen, da sie 

beide der Exposition Nord entsprechen) > unter Outputraster Bezeichnung festlegen 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

   
Tab. 1: Einteilung der Expositionsklassen 

 

Neigungsverteilung 

Die Hangneigung wurde in Grad angegeben und in 9 Klassen ả 10° eingeteilt. Hänge mit einer 

Neigung zwischen 0° - 10° wurden dabei als schwach, zwischen 10° - 50 ° als mittel und 

zwischen 50° - 90° als stark geneigt bezeichnet (vgl. LOUIS & FISCHER 1979). 

Erstellen der Neigungsklassifikation im GIS: 

 DGM laden  

Exposition Azimut in Grad

Nord   0,01° - 22,5° / 337,5° - 360°

Nordost   22,5°  -    67,5°

Ost   67,5°  -  112,5°

Südost 112,5°  -  157,5°

Südost 157,5°  -  202,5°

Südwest 202,5°  -  247,5°

West 247,5°  -  292,5°

Nordwest 292,5°  -  337,5°
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 Spatial Analyst > Surface Analysis > Slope (Input surface: DGM, Outputmeasurement: Degree, Z factor: 

1, Cellsize: 10, Outputraster: Bezeichnung festlegen) > ok  

 Spatial Analyst > Reclassify  > Inputraster: berechnete Neigung > Classify > unter „Classification“ 9 

Klassen festlegen > unter „Break Values“ Neigungsstufen eingeben (10, 20, 30…..) > ok > unter 

„Outputraster“ Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

Einstrahlsituation  

Die Berechnung der Einstrahlsituation setzte die Azimuthwerte der einfallenden Sonnenstrahlen 

und die Sonnenstandhöhe bei entsprechender Uhrzeit voraus. Diese stammen aus einer 

Sonnenpositionsberechnung für das Jahr 2004 (QUASCHNING 2003, http://www.volker-

quaschning.de/datserv/sunpos/index.html). Die genauen Werte dazu befinden sich im Anhang 

(siehe A 1). Da die Werte jahres- und uhrzeitabhängig sind, ergaben sich unterschiedliche 

Sonnenverhältnisse. Um interessante Aussagen zu erlangen, wurde die Besonnung für den 21. 

Dezember, den kürzesten Tag mit dem niedrigsten Sonnenstand, und den 21. Juni, den längsten 

Tag mit dem höchsten Sonnenstand, berechnet. Dies erfolgte zu beiden Jahreszeiten um 8 Uhr, 

12 Uhr und 16 Uhr, im Sommer zusätzlich um 20 Uhr. Für die Wintermonate wurde dabei die 

Mitteleuropäische Zeit (MEZ) und für die Sommermonate die Mitteleuropäische Sommerzeit 

(MESZ) angewandt. Bei den Berechnungen sind alle außerhalb der Untersuchungsgebiete 

liegende Reliefeinflüsse miteinbezogen worden. Himmelsstrahlung oder Bewölkung wurden 

nicht berücksichtigt.  

Berechnen der Einstrahlsituation im GIS: 

 DGM laden  

 Spatial Analyst > Surface Analysis > Hillshade (Input surface: DGM, Azimuth: je nach Jahres- und 

Uhrzeit, nachzusehen in A 1, Altitude: je nach Jahres- und Uhrzeit, nachzusehen in A 1, Model shadows 

aktivieren, Z factor: 1, Cellsize: 10, Outputraster: Bezeichnung festlegen) > ok  

 Spatial Analyst > Reclassify  > Inputraster: berechnetes Hillshade > Classify > unter „Classification“ 2 

Klassen festlegen > unter „Break Values“ Wert 1 und jeweils max Wert eingeben > ok > „New Values“ 

neu definieren: „Old Value“ 1 wird gleich 0 gesetzt und der „Old value“ max. Wert wird gleich 1 gesetzt 

(0=Schatten, 1= Sonne) > unter „Outputraster“ Bezeichnung festlegen und abspeichern 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
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2.3.2 Biotischer Umweltfaktor 

Da die Luftbildklassifikation zu differenziert ist, erfolgte eine neue, zusammenfassende 

Einteilung in 10 Klassen. Diese ist in nachstehender Tabelle (vgl. Tab.2) aufgeführt:  
 

Tab. 2: Einteilung der Biotoptypen 

1 Nadelwald dicht
2 Nadelwald licht
3 Mischwald
4 Laubwald
5 Latschen

6
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden

7 Fels / Steinschutt / Kies

8 Moor

9 Versiegelte Flächen
10 Nicht definiert  

 

Erstellen der Biotoptypenklassifikation im GIS:  

 Luftbildklassifikation („Naturraum_fertig_plg“) laden >mit re Maustaste auf Properties > über 

„Join&Relates“  mit „Hauptabelle_19_5_03“ verbinden (über das Feld „Flächennummer“);  unter 

„VegetationsgesellschaftenNat.Inv“ steht der dazugehörige Erhebungsschlüssel 

 Luftbildklassifikation liegt als shape-file vor, muss für die weiteren Berechnungen in ein Rasterformat 

umgewandelt werden: Spatial Analyst > Convert > Features to Raster 

(Inputraster:„Naturraum_fertig_plg“; Field: Vegges_gro; Outputraster: Bezeichnung festlegen;  Cellsize: 

10) > ok 

 Reklassifizierung: Spatial Analyst > Reclassify > Inputraster: Biotoptypen;  bei den „New Values“ werden 

den Biotoptypen jeweils die in Tab.2 ersichtlichen Werte zugeordnet 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
 

 
2.3.3 Weiterführende Analysen 

Um Aussagen bezüglich der potentiellen Brutfelsen und Lawinenareale, der Einsehbarkeit in das 

Gelände sowie der Thermik treffen zu können, wurden die abiotischen Umweltfaktoren mit den 

biotischen entsprechend kombiniert.  
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Potentielle Brutfelsen 

Alle Flächen des Biotoptyps „Fels“, deren Hangsteilheit größer 50° ist und die in einer Höhe 

zwischen 800 m – 1.900 m ü. A liegen, werden als potentielle Brutfelsen bezeichnet. Die 

Auswahl dieser Merkmale basiert auf der Auseinandersetzung mit entsprechender Fachliteratur.  

Es kommen zwar auch regelmäßig Baumhorste vor, jedoch sind in den mitteleuropäischen Alpen 

die Horststandorte hauptsächlich in Felswänden, -spalten, -nischen, -halbhöhlen und –simsen zu 

finden (KOSTRZEWA 1995). Flächen mit einer Neigung größer 50° können als steil angesehen 

werden und weisen wandähnliche Kriterien auf. Bisherige Horstnachweise im Planungsgebiet 

bestätigen dies (DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH). Bezüglich der Höhenlage 

befinden sich die Horste meist einige hundert Meter über dem Talboden und immer unterhalb 

der Jagdgebiete, um somit ein energiesparendes Einbringen der Beute in den Horst zu 

gewährleisten (KOSTRZEWA 1995, BEZZEL & FÜNFSTÜCK 1994). Laut BRENDEL et al. (2000) 

entspricht das in den Bayerischen Alpen einer Höhe zwischen ungefähr 790 m – 1.900 m ü. A. 

Die Ennstaler Alpen, zu denen u.a. das Planungsgebiet des Nationalparks Gesäuse gehört, zählen 

wie die Bayerischen Alpen ebenso zu den Nördlichen Kalkalpen, weshalb dort eine ähnliche 

Höhenlage der Horste angenommen werden kann. 

Berechnen der Potentiellen Brutfelsen im GIS: 

 Neigung, Höhenstufen und Biotoptypen laden 

 Spatial Analyst > Raster Calculator > als Layer „Neigung“ wählen > Neigung größer 50° berechnen 

(Neigung>50) 

 Spatial Analyst > Raster Calculator > als Layer „Höhe“ wählen > Höhenstufen zwischen 800 m und 1.900 

m ü. A berechnen (Höhe>800 and Höhe<2000) 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptyp „Fels“ berechnen 

(Biotoptyp=7) 

 diese drei Berechnungen nun miteinander verschneiden: Spatial Analyst > Raster Calculator > 

Neigung*Höhe*Biotoptypen > Evaluate 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

Potentielle Lawinenhänge 

Hänge mit einer Neigung zwischen 30° - 50° werden als besonders lawinengefährdet angesehen. 

Ist der Winkel kleiner 30° bleibt der Schnee liegen. Bei über 50° ist das Gelände zu steil, als dass 

sich dort über längere Zeit große Schneemengen ansammeln können (KONNERT 2001). Zudem 
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entstehen Lawinen bevorzugt auf Flächen, die den Biotoptypen „Alpiner Rasen“ oder „Fels“ 

zugeordnet werden. Auf Grund der spärlichen Vegetation erfährt der Schnee dort keine 

Stabilisation und gerät schnell ins rutschen, ohne aufgehalten zu werden. Um eine grobe 

Verteilung der potentiellen Lawinenareale zu erhalten, sind Flächen mit diesen Eigenschaften 

aussagekräftig (http://lawinen.nweb.ch/lawinen.html, 

http://www.wsl.ch/slf/avalanche/avalanche-de.html).  

Berechnen der Potentiellen Lawinenhänge im GIS: 

 Neigung und Biotoptypen laden 

 Spatial Analyst > Raster Calculator > als Layer „Neigung“ wählen > Neigung zwischen 30° und 50° 

berechnen (Neigung>30 and Neigung<60) 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptypen „Fels“ und 

„Alp.Rasen“ berechnen (Biotoptyp=6 and Biotoptyp=7) 

 diese zwei Berechnungen nun miteinander verschneiden: Spatial Analyst > Raster Calculator > 

Neigung*Biotoptypen > Evaluate 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

Einsehbarkeit in das Gelände 

In der nachfolgenden Tab.3 wurden den jeweiligen Biotoptypen Werte bezüglich ihrer 

durchschnittlichen Einsehbarkeit zugeordnet. Der Wert 0 entspricht dabei einem nicht 

einsehbaren Gelände, wohingegen der Wert 100 eine Einsehbarkeit von 100 % ermöglicht. Die 

Wertfindung erfolgte nach BÖGEL (1995) und EBERHARDT (1996). Die in diesen Arbeiten nicht 

berücksichtigten Vegetationstypen wurden nach eigenem Beurteilungsvermögen der Autorin 

festgelegt. Aus Gründen der Anschaulichkeit erfolgte in den Diagrammen und Karten eine 

Einteilung des Parameters in die Klassen „gering“ (10 % - 30 %), „mittel“ (40 % - 70 %) und 

„hoch“ (80 % - 100 %).  

Wegen des Laubabfalls im Herbst unterscheidet sich der Bewertungsfaktor bei den Laub- und 

Mischwäldern zwischen den Sommer- und Wintermonaten. Für die anderen Biotoptypen ist 

diese Differenzierung nicht nötig. 
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Tab. 3: Wertzuweisung bezüglich der mittleren 
Durchschnittlichen Einsehbarkeit 

Sommer Winter
Nadelwald dicht 30 30
Nadelwald licht 50 50
Mischwald 30 50
Laubwald 30 50
Latschen 60 60
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden 100 100
Fels / Steinschutt / Kies 100 100
Moor 100 100
Versiegelte Flächen 60 60
Nicht definiert 0 0

Bewertungsfaktor in %
Biotoptyp

 

 
Berechnen der Einsehbarkeit in das Gelände im GIS: 

 Biotoptypen laden 

 Spatial Analyst > Reclasssify > Inputraster:Biotoptypen; „New Values“ neu definieren (Wertzuweisung 

nach Tab.3, je nach Jahreszeit) 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
 

 

Mit zunehmender Annäherung an die obere Waldgrenze werden alle Waldbereiche immer lichter 

und es erhöht sich ihre Einsehbarkeit. Da diese Grenze in den Nördlichen Kalkalpen etwa bei 

1.800 m ü. A liegt, werden alle Waldregionen zwischen 1.600 m und 1.800 m ü. A in der 

vorliegenden Arbeit als „Lichter Wald“ definiert. Hinzugezählt wird hier ebenso der Biotoptyp 

„Nadelwald licht“. Die Einsehbarkeit dieser „Lichten Wälder“ wird mit größerer Hangsteilheit 

positiv beeinflusst, da dann kein geschlossenes Kronendach mehr vorhanden ist und einzelne 

Stammabschnitte erkennbar werden (BÖGEL 1995). Um diesen Sachverhalt zu berücksichtigen, 

wurden alle Flächen, die dem Biotoptyp „Lichter Wald“ entsprechen und eine Hangneigung 

größer 50° besitzen, als „Lichter Steiler Wald“ bezeichnet.  

Es erfolgte eine getrennte Betrachtung der Geländeabschnitte mit den Merkmalen „Lichter 

Wald“ oder „Lichter Steiler Wald“. Diese Gebiete sind von besonderer Bedeutung für den 

Steinadler, da sie dem Greifvogel neben einer hohen Einsehbarkeit (vgl. BÖGEL 1996) zudem 

eine gute Deckung während der Jagd ermöglichen. 
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Berechnen der Flächen mit den Eigenschaften „Lichter Wald“ und „Lichter Steiler Wald“ im GIS:  

 Höhenstufen, Biotoptypen und Neigung laden 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptypen mit der Eigenschaft 

Wald berechnen (Biotoptypen = 1 or Biotoptypen = 2 or Biotoptypen = 3 or Biotoptypen = 4) 

 Spatial Analyst > Raster Calculator > als Layer „Höhe“ wählen > Höhe zwischen 1.600 m und 1.800 m ü. 

A berechnen (Höhe >1.500 and Höhe <1.900) 

 diese zwei neuen Berechnungen miteinander verschneiden: Spatial Analyst > Raster Calculator > 

Biotoptypen * Höhe > Evaluate  (Ergebnis: lichter Wald in der Region der Waldgrenze) 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptyp „Nadelwald licht“ 

berechnen (Biotoptyp=2) 

 Berechnung „Lichter Wald in der Region der Waldgrenze“ und „Nadelwald licht“ zusammenfügen: 

Spatial Analyst > Raster Calculator > „Lichter Wald in der Region der Waldgrenze“ + „Nadelwald licht“ 

(Ergebnis: alle Flächen, die lichten Wald aufweisen) 

 Spatial Analyst > Raster Calculator > als Layer „Neigung“ wählen > Neigung größer 50° berechnen 

(Neigung>50) 

 Errechnete Neigung und lichte Waldflächen miteinander verschneiden: Spatial Analyst > Raster 

Calculator > steile Neigung * lichte Waldflächen  (Ergebnis: Lichter Steiler Wald) 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
 

Thermik 

Für die Berechnung des thermischen Aufwinds im Sommer, sind die Parameter 

„Einstrahlsituation“ und „Biotoptypen“ miteinander verschnitten worden. Für den bei 

schneebedeckter Landschaft wurde ebenso der Faktor „Neigungsverteilung“ hinzugezogen. Die 

Einstrahlsituation bezieht sich auf den 21.6.04 sowie den 21.12.04 um jeweils 12 Uhr. Zu dieser 

Zeit erreicht die Sonne ihren jeweiligen Höchststand am Tag und es werden die meist möglichen 

Geländeoberflächen bestrahlt. Auf diesen entwickelt sich dann gegen etwa 13 Uhr die maximale 

Thermik. Die Entstehung dieser hängt sehr stark vom Untergrund mit seiner Bodenbedeckung 

und dessen Fähigkeit zur Bodenerwärmung ab. Die Bewertung der Biotoptypen nach ihrem 

Thermikpotential richtet sich im Wesentlichen nach EBERHARDT (1997), der im Rahmen einer 

Habitatmodellierung hierfür einen passenden Wertfindungsbaum definiert hat. Nicht vorhandene 

Biotoptypen wurden nach eigenem Ermessen der Autorin beurteilt. Legt man auf einer Skala von 

0 – 100 den Bewertungsfaktor für den Biotoptyp „Fels“ als Maximum (Thermikpotential = 100) 

und für Schnee als Minimum (Thermikpotential = 10) fest, so hat sich für den Sommer folgende 

Anordnung ergeben (siehe Tab.4): 
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Tab. 4: Bewertung der Biotoptypen bezüglich  
ihres Thermikpotentials im Sommer 

Biotoptyp Bewertungsfaktor in %
Nadelwald dicht 60
Nadelwald licht 50
Mischwald 50
Laubwald 50
Latschen 60
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden 80

Fels / Steinschutt / Kies 100
Moor 10
Versiegelte Flächen 100
Nicht definiert 0  

 

Berechnen der sommerlichen Thermiksituation im GIS: 

 Biotoptypen laden 

 Spatial Analyst > Reclasssify > Inputraster: Biotoptypen; „New Values“ neu definieren (Wertzuweisung 

nach Tab.4) 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
 

Bei schneebedeckter Landschaft hat sich eine wesentlich geringere Bewertung ergeben (vgl. Tab. 

5). Auf vegetationslosen Flächen und Bereichen mit niedrig wachsender Vegetation, deren 

Hangneigung kleiner 50° ist, hält sich der Schnee dauerhaft und es kommt kaum zu einer 

Thermikentstehung. Deshalb wurde ihnen ein Thermikpotentialwert von 10 zugeordnet. Ist die 

Hangsteilheit hier größer als 50°, kann sich der abgesetzte Schnee schlecht halten, rutscht ab und 

gibt die darunter liegende Geländeoberfläche frei (KONNERT 2001). Die Bewertung der 

Biotoptypen „Alpiner Rasen / Magerr. / Wiesen / Hochst. / Sauerböden“ und „Fels“ bezüglich 

ihrer Thermikentwicklung erfolgt dann wie im Sommer.  

Wälder erhielten den Wert 30, da sie im Kronenbereich normalerweise nicht lange 

schneebedeckt bleiben. Versiegelten Gebieten wurde der gleiche Bewertungsfaktor zugeordnet. 

Grund hierfür ist die menschliche Nutzung bzw. Abwärme durch Heizen, die den Schnee 

schneller abtauen lässt (EBERHARDT 1997). 
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Tab. 5: Bewertung der Biotoptypen bezüglich ihres  
Thermikpotentials im Winter 

Biotoptyp Bewertungsfaktor in %
Nadelwald dicht 30
Nadelwald licht 30
Mischwald 30
Laubwald 30
Latschen 30
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden unter 
50° Neigung 10
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden über 50° 
Neigung 80
Fels / Steinschutt / Kies unter 
50° Neigung 10
Fels / Steinschutt / Kies über 
50° Neigung 100
Moor 10
Versiegelte Flächen 30
Nicht definiert 0  

 
 

Berechnen der winterlichen Thermiksituation im GIS: 

 Biotoptypen und Neigung laden 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptyp „Alp. Rasen“ 

berechnen (Biotoptyp=6) 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptyp „Fels“ berechnen 

(Biotoptyp=7) 

 Spatial Analyst > Raster Calculator > als Layer „Neigung“ wählen > Neigung größer 50° berechnen 

(Neigung>50) 

 Alp. Rasen über 50° berechnen: Spatial Analyst > Raster Calculator  (Alp. Rasen *  Neigung über 50°) 

 Alp. Rasen unter 50° berechnen: Spatial Analyst > Reclassify > Inputraster: Alp. Rasen über 50°; „New 

Value“ neu definieren („Old Value“ 1 = „New Value“ 0 und „Old Value“ 0 = „New Value“ 1)  

 Fels über 50° berechnen: Spatial Analyst > Raster Calculator  (Fels *  Neigung über 50°) 

 Fels unter 50° berechnen: Spatial Analyst > Reclassify > Inputraster: Fels über 50°; „New Value“ neu 

definieren („Old Value“ 1 = „New Value“ 0 und „Old Value“ 0 = „New Value“ 1)  

 Biotoptypen ohne Alp. Rasen und Fels berrechnen: Spatial Analyst > Raster Calculator > als Layer 

„Biotoptypen“ wählen > Biotoptypen ohne Alp. Rasen und Fels berrechnen (Biotoptyp=1 or Biotoptyp=2 

or Biotoptyp=3 or Biotoptyp=4 or Biotoptyp=5 or Biotoptyp=8 or Biotoptyp=9 or Biotoptyp=10) 

 Spatial Analyst > Raster Calculator > „ Biotoptypen ohne Alp. Rasen und Fels“ * „ Biotoptypen“ 

(Ergebnis: Biotoptypen ohne Alp. Rasen und Fels, aber mit Wertzuweisung) 
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 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“)    

 Spatial Analyst > Reclasssify > Inputraster: „Biotoptypen ohne Alp. Rasen und Fels, aber mit 

Wertzuweisung“; „New Values“ neu definieren (Wertzuweisung nach Tab.5) 

 Spatial Analyst > Reclasssify > Inputraster: „Alp. Rasen unter 50°“; „New Values“ neu definieren 

(Wertzuweisung nach Tab.5) 

 Spatial Analyst > Reclasssify > Inputraster: „Alp. Rasen über 50°“; „New Values“ neu definieren 

(Wertzuweisung nach Tab.5) 

 Spatial Analyst > Reclasssify > Inputraster: „Fels unter 50°“; „New Values“ neu definieren 

(Wertzuweisung nach Tab.5) 

 Spatial Analyst > Reclasssify > Inputraster: „Fels über 50°“; „New Values“ neu definieren 

(Wertzuweisung nach Tab.5) 

 Zusammenfügen aller Flächen mit der neuen Wertzuweisung: Spatial Analyst > Raster Calculator >alle 

Berechnungen mit neuer Wertzuweisung (Ergebnisse der  letzten 5 Arbeitsschritte) miteinander addieren 

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“)    

 

Es ist darauf hinzuweisen, dass in den Diagrammen und Karten aus Gründen der 

Anschaulichkeit eine Einteilung der Thermik in die Klassen „null“ (0 %), „gering“ (10 % - 

 30 %), „mittel“ (40 % - 60 %), „stark“ (70 % - 90 %) und „sehr stark“ (100 %) verwendet 

wurde. 
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3 Ergebnisse 

Die berechneten Werte der einzelnen Parameter wurden in tabellarischer Form zusammenfasst 

sowie in Diagrammen und GIS-Karten wiedergegeben. Im Folgenden wurden jeweils die 

Darstellungen gewählt, die den Sachverhalt am besten veranschaulichen. Die entsprechenden 

Datengrundlagen sind im Anhang zu finden. Es ist darauf hinzuweisen, dass sich bei allen 

berechneten Ergebnissen auf Grund der Rundung auf zwei Dezimalstellen geringe 

Abweichungen ergeben können. 

Die Erstellung der Karten erfolgte mit ArcGis9.0. Die räumliche Darstellung der Analysen basiert auf den im GIS 

durchgeführten Berechnungen. Da die GIS-Analysen im Rasterformat durchgeführt wurden wird als Grundeinheit 

eine Rasterzelle verwendet. Um die exakten Flächenanteile der einzelnen Parameter in % zu erhalten, erfolgten 

zusätzliche Berechnungen mit Hilfe von Microsoft Office Excel 2003. Die Grundlagendaten besitzen eine Auflösung 

von 10 m * 10 m.  Die Fläche einer Rasterzelle entspricht somit 100 m2 bzw. 0,0001 km2. Um den jeweiligen 

Prozentanteil bezogen auf das gesamte Untersuchungsgebietes zu erhalten, wird die berechnete Fläche durch die 

Fläche des Untersuchungsgebietes (124,98 km2) geteilt und mal 100 genommen, z.B. 0,0001 / 124,98 * 100. Mit 

Microsoft Office Excel erfolgte anschließend auch die Erstellung der dazugehörigen Diagramme. 

 

3.1  Auswertung der abiotischen Umweltfaktoren im Untersuchungsgebiet  

3.1.1    Profil  

Für die Auswertung dieses Parameters wurde die Alpenvereinskarte des Untersuchungsgebietes 

hinzugezogen (ÖSTERREICHISCHER ALPENVEREIN 2002). Der Profilschnitt ist in Abb.2 ersichtlich. 

 

 
Abb. 2: Profil des Untersuchungsgebietes (NW – SE) 

 

Das charakteristische Landschaftsbild des Planungegebietes ist durch die tief eingeschnittenen, 

V-förmigen Täler der Enns (Ø 555 m ü. A) und des Johnsbachs (Ø 660 m ü. A) gegliedert. Diese 

teilen das Untersuchungsgebiet in drei Gebirgsmassive: Das Buchsteinmassiv (max.  
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2.224 m ü. A) nördlich der von West nach Ost verlaufenden Enns sowie die südlich der Enns 

liegende Admonter Reichenstein- (max. 2.251 m ü. A) und die Hochtorgruppe (max.  

2.370 m ü. A), die wiederum durch das Johnsbachtal voneinander getrennt werden. Der 

Gebirgsstock des Admonter Reichensteins liegt dabei westlich und das Hochtormassiv östlich 

des von Süd nach Nord verlaufenden Johnsbachs.   

Da das Planungsgebiet des Nationalparks Gesäuse hauptsächlich durch die Buchstein- und die 

Hochtorgruppe sowie das dazwischen liegende Ennstal geprägt ist, werden die typischen 

Eigenschaften des Untersuchungsgebietes durch den von Nordwest nach Südost gelegten 

Profilschnitt (siehe Abb.2) erfasst.  

Der maximale Höhenunterschied ist zwischen den Ufern der Enns (etwa 500 m ü. A) und dem 

Hochtor (2.370 m ü. A) zu finden und beträgt 1.870 m. Auf Grund dieser orographischen 

Gegebenheiten ist im Planungsgebiet eine stark gekammerte Landschaft vorhanden.  

 

3.1.2    Höhenverteilung 

Das Planungsgebiet des Nationalparks Gesäuse erstreckt sich von etwa 500 m ü. A bis auf  

2.370 m ü. A. Nach der Höhenklassifizierung der vorliegenden Arbeit nimmt die hochalpine 

Landschaft somit 20 Klassen ein. Ein deutlicher Schwerpunkt der Höhenverteilung liegt in den 

mittleren Lagen zwischen 601 m - 1.800 m ü. A (siehe A 2). Die in diesem Bereich liegenden 

Höhenklassen besitzen jeweils eine Flächenausdehnung von ungefähr 6 % - 8,5 % des 

Planungsgebietes. Die 1.500 m - Höhenklasse hebt sich dabei mit 8,61 % Flächenanteil als 

absolutes Maximum hervor. Es lässt sich ableiten, dass das Untersuchungsgebiet zu über 43 % 

durch die montane und zu über 30 % durch die subalpine Höhenstufe geprägt ist (siehe Abb.3). 

Der unter 800 m ü. A liegende submontane Bereich nimmt ein Areal von 15,95 % ein. Mit 

zunehmender Höhe erfolgt dort ein Anstieg der Flächenanteile der einzelnen Klassen. 

Entgegengesetzt dazu verhalten sich die Flächenausdehnungen der Höhenklassen des alpinen 

Bereichs. Hier nimmt der Anteil mit der Höhe kontinuierlich ab. Im Gesamten macht diese Stufe 

10,34 % des Gebietes aus.  



 

 

Höhenstufenverteilung im 
Planungsgebiet des Nationalparks Gesäuse

±

Verfasser: Sina Hölscher
Datum: 08.09.2005

Höhenstufen
submontan (400 m - 800 m ü. NN)

montan (800 m - 1400 m ü. NN)

subalpin (1400 m - 1800 m ü. NN)

alpin (1800 m - 2800 m ü. NN)

43,66

15,95

10,34

30,05

0

5

10

15

20

25

30

35

40

45

50

Submont an Mont an Subalpin Alpin

H öhe nst u fe n

Grenze Planungsgebiet

0 5.000 10.0002.500
Meters

 
 Abb. 3: Höhenstufenverteilung im Untersuchungsgebiet   
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3.1.4    Expositionsverteilung 

Wie anhand der Abb.4 deutlich wird, liegt der flächenmäßige Anteil der einzelnen Expositionen 

im Planungsgebiet des Nationalparks Gesäuse weitgehend zwischen 10 % und 16 %. Eine 

gravierende Ausprägung der dortigen Landschaft ist somit nicht gegeben. Es lässt sich jedoch 

erkennen, dass die Expositionen Süd und Südost mit jeweils über 15 % Flächenanteil sowie die 

Ausrichtungen Nord und Nordwest mit knappen 14 % der Gebietsausdehnung etwas stärker 

vertreten sind. Eine leichte Ausrichtung der Gebirgsstöcke von West/Südwest nach Nordost/Ost 

ist deshalb erkennbar. Die Flachbereiche ohne Expositionszuweisung sind mit 0,01 % nur sehr 

gering. 

 

Bei Betrachtung der räumlichen Verteilung der Expositionen fällt deutlich die naturräumliche 

Unterteilung des Untersuchungsgebietes auf Grund des durchlaufenden Ennstals auf (siehe 

Abb.4). Das nördlich der Enns und nur teilweise im Planungsgebiet liegende Buchsteinmassiv 

definiert sich hauptsächlich durch südliche und östliche Expositionen. Die ebenso nur 

abschnittsweise im Untersuchungsgebiet liegende Admonter Reichensteingruppe ist v.a. durch 

östliche Expositionen auszumachen. Dagegen weist die, sich fast vollständig im 

Untersuchungsgebiet befindende, Hochtorgruppe alle Expositionen auf. Auf der nach Osten 

ausgerichteten Seite dieses Gebirgsmassivs sind kleinere Geländekammern erkennbar.  
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Abb. 4: Expositionsverteilung im Untersuchungsgebiet 
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3.1.5    Neigungsverteilung 

Wie in der Abb.5 deutlicht wird, ist das Planungsgebiet des Nationalparks Gesäuse zu 78,08 % 

durch eine mittlere Neigung geprägt. Die Neigungsstufe zwischen 30° - 40° ist mit 34,72 % 

Flächenanteil dabei am stärksten vertreten (siehe A 4). Das restliche Gelände dieses hochalpinen 

Untersuchungsgebietes setzt sich zu 16,92 % aus stark geneigten und nur zu 5 % aus flachen 

bzw. ebenen Bereichen zusammen. Daran lässt sich deutlich der hochalpine Charakter des 

Geländes erkennen, mit verhältnismäßig vielen, schroffen Geländebereichen. 
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Abb. 5: Neigungsverteilung im Untersuchungsgebiet    
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3.1.6    Einstrahlsituation 

Sommer 

Morgens um 8 Uhr sind im Untersuchungsgebiet 64,56 % der Flächen besonnt (vgl. Abb.6) und 

der Schattenwurf der umliegenden Gebirgsstöcke ist eindeutig auszumachen. Gegen Mittag bis 

in den Nachmittag hinein liegt hingegen fast das gesamte Planungsgebiet in der Sonne. So 

werden um 12 Uhr etwas über 96 % und um 16 Uhr noch immer knappe 92 % der Flächen 

bestrahlt. Abends um 20 Uhr befinden sich dagegen nur noch 21,5 % der Geländeoberflächen in 

der Sonne. Zu dieser Zeit ist die große Reliefenergie und somit die Abschattwirkung der 

hochalpinen Landschaft erneut deutlich erkennbar. 

Winter 

Am 21.12.04 besitzt das Planungsgebiet des Nationalparks Gesäuse zum Zeitpunkt des 

Sonnenhöchststands lediglich einen Sonnenanteil von 44,86 %. Hauptsächlicher Grund hierfür 

ist die starke Abschattung durch das Gebirgsmassiv der Hochtorgruppe (siehe Abb.7). Morgens 

um 8 Uhr sowie nachmittags um 16 Uhr befindet sich das gesamte Untersuchungsgebiet fast 

vollständig im Schatten und es werden nur 6,45 % bzw. 7,81 % der Oberfläche mit Sonne 

beschienen.    
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Abb. 6: Einstrahlsituation im Untersuchungsgebiet am 21.6.04 
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 Abb. 7: Einstrahlsituation im Untersuchungsgebiet am 21.12.04  
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3.2  Auswertung des biotischen Umweltfaktors im Untersuchungsgebiet 
 
Wie sich in Abb.8 erkennen lässt, ist das Planungsgebiet des Nationalparks Gesäuse zu 53,11 % 

von Wald geprägt. Der Nadelwald stellt dabei - mit über 2/3 Anteil an der Gesamtwaldfläche -

den dominierenden Waldtyp dar, gefolgt von Mischwäldern mit 11,25 % Gebietsanteil. 

Laubwälder nehmen mit 2,98 % Flächenausdehnung nur verschwindend geringe Bereiche ein.   

Am zweitstärksten vertreten ist der Biotoptyp „Latschen“, der in den höheren Lagen der drei 

prägenden Gebirgsstöcke, v.a. um die Hochtorgruppe, zu finden ist (siehe Abb.8). Sein Anteil 

beträgt 19,96 % und nimmt somit etwa 1/5 des Untersuchungsgebietes ein. Felsflächen prägen 

mit 16,26 % einen fast ebenso großen Bereich des Gebietes. Zu begründen ist dies mit der 

verhältnismäßig stark vertretenen alpinen Höhenstufe über der Waldgrenze und der Steilheit des 

hochalpinen Geländes, die verantwortlich ist für diese vegetationslosen Einheiten. Großflächige, 

einheitliche Felsareale konzentrieren sich hauptsächlich in den höher liegenden Regionen der 

drei Gebirgsstöcke. 

Auffällig ist der sehr geringe Anteil offener Vegetationsformen wie Alpiner Rasen, Magerrasen 

und Wiesen. Sie sind lediglich auf 7,84 % der Gebietsoberfläche zu finden und dabei fast 

ausschließlich im Bereich der Hochtorgruppe sowie der Region am Tamischbachturm (siehe 

Abb.8). Zu erklären ist dies mit der hauptsächlich durch Fels bestimmten alpinen Höhenstufe, 

die deshalb nur geringe Anteile an Alpinen Rasen aufweist. Der größte Teil des Biotoptyps 

„Alpiner Rasen“ - fast doppelt soviel wie in der alpinen Höhenstufe - ist in der tiefer liegenden, 

subalpinen Höhenstufe auf Grund der dort vorhandenen Almflächen zu finden. Zu nennen sind 

z.B. die großen Flächen um die Sulzkaralm, die Haselalm und die Neuburgalm (vgl. 

ALPENVEREINSKARTE). 

Alle weiteren Biotoptypen nehmen im Planungsgebiet einen zu vernachlässigenden 

Flächenanteil ein. 
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Abb. 8: Biotoptypenverteilung im Untersuchungsgebiet 
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3.3  Auswertung der weiterführenden Analysen im Untersuchungsgebiet 
 
3.3.1    Potentielle Brutfelsen 

Obwohl das Untersuchungsgebiet viele felsige Areale aufweist und das Gelände im Durchschnitt 

mittel bis steil geneigt sowie gekammert ist, eignen sich nur 4,24 % der Gesamtfläche des 

Planungsgebietes als Brutstätte im Fels. Diese potentiellen Brutfelsen sind hauptsächlich auf der 

Nordseite des Hochtormassivs, zwischen Großem und Kleinem Buchstein und am Admonter 

Reichenstein zu finden (vgl. Abb.9).   
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Abb. 9: Potentielles Brutfelsangebot im Untersuchungsgebiet 
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3.3.2    Potentielle Lawinenareale 

Wie in Abb.10 ersichtlich ist, macht der flächenmäßige Anteil an lawinengefährdeten Arealen im 

hochalpinen Untersuchungsgebiet etwa 10,06 % der Fläche aus. Begründet liegt dies in dem 

durchschnittlich steileren und felsigeren Gelände des Planungsgebietes. Lawinenfördernde 

Merkmale, wie Hangneigungen zwischen 30° - 50° (siehe ANHANG) oder der Biotoptyp Fels 

(siehe Kapitel 3.2), sind dort sehr stark vertreten. Potentielle Lawinenareale finden sich 

hauptsächlich im Bereich des Buchsteins, Tamischbachturms, Reichensteins, des Lugauers und 

der gesamten Hochtorgruppe. Bisher erhobene Lawinenstriche bestätigen die Art der 

Berechnung (siehe Abb.10). Diese Erfassung erfolgte jedoch nur in tiefer liegenden Bereichen, 

wo eine Gefährdung für den Menschen bzw. die Infrastruktur besteht.   
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Abb. 10: Potentielle Lawinenareale im Untersuchungsgebiet 
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3.3.3    Einsehbarkeit in das Gelände 

Sommer und Winter 

Hinsichtlich der Einsehbarkeit in das Untersuchungsgebiet sind deutliche Unterschiede zwischen 

den Jahreszeiten zu erkennen (siehe Abb.11). Eine differenzierte Betrachtung der errechneten 

Werte ist in A 8 und A 9 möglich.  

In den Sommermonaten dominieren mit circa 40 % Flächenanteil, die Bereiche mit einer 

geringen Einsehbarkeit. Dies lässt sich durch den großen Waldanteil erklären. Die restliche 

Landschaft setzt sich zu etwa 33 % aus Gelände mit mittlerer und zu etwa 24 % mit Gebieten 

hoher Einsehbarkeit zusammen (siehe Abb.11).  

In den Wintermonaten bleibt der Anteil der Flächen, auf denen eine hohe Einsehbarkeit 

gewährleistet wird, gleich groß wie im Sommer (siehe Abb.11). Die Einsehbarkeitsbedingungen 

in das restliche Planungsgebiet unterscheiden sich jedoch. So verringert sich der Anteil der 

Regionen, in die nur gering eingesehen werden kann auf 25,78 % zugunsten der Gebiete mit 

mittlerer Einsehbarkeit. Diese erlangen nun eine Flächenausdehnung von 47,53 % und machen 

somit fast die Hälfte des Untersuchungsgebietes aus. Diese Tatsache liegt in den Laub- und 

Mischwaldarealen begründet. Beide Waldtypen sind in den Sommermonaten nur gering 

einsehbar. Auf Grund des herbstlichen Laubabfalls ändert sich jedoch diese Eigenschaft und im 

Winter ist dort eine mittlere Einsehbarkeit gegeben. Im stark bewaldeten – aber hauptsächlich 

durch Nadelwald dominierten - Planungsgebiet findet dieser Wandel zwischen den Jahreszeiten 

nur auf 14,23 % der Gebietsfläche statt.  

Zusammenfassend lässt sich feststellen, dass das Planungsgebiet ganzjährig eine verhältnismäßig 

hohe Einsehbarkeit gewährleistet. So weisen im Sommer 71,80 % und im Winter 89,58 % der 

Landschaft eine Einsehbarkeit von über 50 % auf (siehe Tab. 13 und A 9).  
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Abb. 11: Einsehbarkeit in das Gelände des Untersuchgsgebietes 
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 „Lichter Wald“ und „Lichter Steiler Wald“ 

Laut den Berechnungen findet sich im Untersuchungsgebiet auf circa 14 % der Oberfläche 

„Lichter Wald“ (siehe Abb.12), wohingegen „Lichter Steiler Wald“ lediglich 2,39 % des 

Gebietes ausmacht (siehe Abb.13). Lichte Waldabschnitte sind mit Ausnahme des Bereiches um 

den Großen und Kleinen Buchstein recht einheitlich im Untersuchungsgebiet verteilt, lichte und 

steile Wälder sind hauptsächlich südlich und südöstlich des Gstatterbodens zu finden.  
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  Abb. 12: Anteil „Lichter Wald“ im Untersuchungsgebiet 

 
 

97,61

2,39
0

20

40

60

80

100

Lichter Steiler Wald restliche Fläche

Anteil Lichter Steiler Wald

Fl
äc

he
na

nt
ei

l i
n 

%

 
  Abb. 13: Anteil „Lichter Steiler Wald“ im Untersuchungsgebiet 

 

3.3.4    Thermik 

Im Sommer ist das Untersuchungsgebiet zu 72 % Anteil hauptsächlich durch Flächen geprägt, 

die eine mittelstarke Thermik ermöglichen (vgl. Abb.14). Dies lässt sich durch den großen 

Waldanteil erklären. Die restliche Landschaft des Planungsgebietes wird überwiegend durch 

Areale mit einer sehr starken (14,85 %) oder starken (7,78 %) Thermik bestimmt. Weitere 

Bereiche, die keine oder nur geringe thermische Aufwinde ermöglichen können vernachlässigt 

werden (siehe Abb.14).  

Die Berechnungen für den Winter beziehen sich auf die Situation, wenn die gesamte Landschaft 

mit Schnee bedeckt ist. Die genauen Werte dazu sind im Anhang nachzulesen. In diesem Fall 

herrscht im Untersuchungsgebiet eine sehr schwache Ausprägung der Thermik (vgl. Abb.14). 
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Auf über 50 % der Flächen entwickelt sich gar keine und im restlichen Gebiet löst sich fast 

ausschließlich nur eine geringe Thermik (41,16 %) ab. Begründet liegen diese Werte in der 

starken Abschattung im Gebiet auf Grund der Kammerung und dem großen Waldanteil. In den 

Kronenbereichen der Bäume kann sich der Schnee meist nicht lange halten, wodurch sich über 

den Waldbereichen zumindest ein geringer thermischer Aufwind entwickeln kann. 

Hervorzuheben sind die Flächen mit sehr starker Thermik, die im Gegensatz zu den fast nicht 

vorhandenen Arealen mit mittelstarker bzw. starker Thermikentwicklung, etwa 2,10 % des 

Planungsgebietes ausmachen. Grund hierfür ist das zum Teil recht steile, vegetationslose 

Gelände, wo der Schnee schnell abrutscht. Bei Sonneneinstrahlung kann sich die 

Bodenoberfläche dadurch ähnlich wie im Sommer erwärmen. 
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  Abb. 14: Thermiksituation im Untersuchungsgebiet 
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4 Auswertung  

4.1  Auswirkung der abiotischen Umweltfaktoren auf die Lebensraumqualität  
 
4.1.1 Profil 

Das Planungsgebiet des Nationalparks Gesäuse setzt sich durch drei markante Gebirgsgruppen 

und zwei dazwischen liegenden V-förmige Täler zusammen. In Verbindung mit der 

Reliefenergie nach HALLER 1996, kann die Region im Allgemeinen als stark gekammert 

bezeichnet werden. Das Untersuchungsgebiet weist jedoch keine, in sich abgeschlossene und für 

den Steinadler geeignete Gebirgskammern auf, um dort ideal einzelne Steinadlerreviere 

einzubetten. Aus diesem Grund befinden sich höchstwahrscheinlich nur Teilbereiche 

verschiedener Reviere innerhalb des Untersuchungsraumes. Die im Gebiet vorhandenen 

markanten topographischen Leitlinien wie z. B. der Berggrat am Hochtor oder der Grat zwischen 

Großem und Kleinem Buchstein, werden mit großer Wahrscheinlichkeit von den dort 

angesiedelten Steinadlern als Revierabgrenzung verwendet. Umrahmende Gebirgsketten dieser 

Art stellen hilfreiche Sichtbarrieren gegen die benachbarten Steinadlerpaare dar und erlauben 

eine klare Abgrenzung (HALLER 1982). 

Die Kammerung einer Landschaft ist aber nicht nur für die Anlage sondern auch für die Größe 

von Revieren mitentscheidend (HALLER 1996). Dies erklärt zumindest teilweise die im 

Alpenraum sehr unterschiedlichen Revierausdehnungen zwischen 35 km2 und 100 km2 (BEZZEL 

& FÜNFSTÜCK 1994, BRENDEL et al. 2000, COULOUMY 1996, HALLER 1996). Auf Grund der 

starken Kammerung im Planungsgebiet des Nationalparks Gesäuse, kann davon ausgegangen 

werden, dass die Reviere eine geringere Ausdehnung besitzen. Diese zweidimensional geringere 

Fläche ist mit einer wesentlich leichteren Revierverteidigung verbunden (HALLER 1994) und 

bedeutet für den Steinadler somit weniger Stress.  

Die von WATSON (1997) erwähnte Abhängigkeit der Reviergröße vom vorhandenen 

Nahrungsangebot trifft auf den Untersuchungsraum nicht zu. Erhebungen und Kartierungen zu 

der Verbreitung der Beutetiere wie z.B. Gams, Birkhuhn, oder Murmeltier (vgl. 

DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH) ergeben, dass dort keine Anzeichen von 

Nahrungsknappheit vorliegen.  

 

4.1.2 Höhenverteilung 

Da der Steinadler ein Jäger der halboffenen und offenen Landschaften ist (HALLER 1996), weist 

er eine große Abhängigkeit gegenüber solchen Arealen auf (WATSON 1997). In den offeneren 
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Flachlandbereichen Mitteleuropas ist der anthropogene Einfluss inzwischen jedoch so stark, dass 

dieser Greifvogel dort keine idealen Lebensbedingungen mehr findet (HALLER 1989). Deshalb 

ist er gezwungen in die Höhe auszuweichen, weshalb die Höhenausdehnung eine sehr 

entscheidende Rolle für ihn spielt: Vor allem die Flächen im Bereich der Waldgrenze (1.600 m – 

1.800 m ü. A) und darüber sind von großer Bedeutung (GLUTZ VON BLOTZHEIM 1971). Diese 

Gebiete sind vegetationsärmer und bieten auf Grund der guten Einsehbarkeit in das Gelände und 

der für ihn guten Erreichbarkeit seiner bevorzugten Beutetiere ideale Jagdbedingungen. Des 

Weiteren eignen sich höher liegende Jagdflächen besser, um die Beute möglichst energiesparend 

in die tiefer liegenden, meist unterhalb der Waldgrenze befindlichen Horste zu transportieren 

(GLUTZ VON BLOTZHEIM 1984).  

In Bezug auf die Jagdansprüche des Adlers weist das Planungsgebiet ausreichend Flächen auf. 

So macht der Anteil der Bereiche über 1.600 m ü. A  fast ¼ des Gebietes aus (vgl. Kapitel 3.1.2). 

Das größte, offene Areal über der Waldgrenze liegt dabei im Südteil des Untersuchungsraumes, 

in der Region um das Hochtor.  

Auch wenn der Steinadler als Nahrungsopportunist auf andere Beutetiere wie z.B. Fuchs, Marder 

oder Haustiere ausweichen kann (KLUTH 1999) und diese Fähigkeit auch nützt, so sind die in 

offeneren Landschaften lebenden Beutetiere für ihn deutlich leichter zu erbeuten und 

ermöglichen ihm die Anwendung optimaler Jagdstrategien. In den Alpen zählen die sich meist 

über der Waldgrenze aufhaltenden Schnee- und Birkhühner (STUBBE 1987), die im Sommer 

höhere Regionen aufsuchenden Gämsen (STUBBE 1988) sowie die v.a. auf hochgelegeneren, 

offenen Flächen lebenden Murmeltiere (STUBBE 1988) zum bevorzugten Beutetierspektrum des 

Steinadlers. Laut der Höhenverteilung finden diese Tierarten im Planungsgebiet genügend 

geeignete Lebensraumgegebenheiten und können dort auch durch Geländenachweise bestätigen 

werden. Murmeltiere kommen jedoch nur im Bereich der Hochtorgruppe vor 

(DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH).  

Der damit einhergehende, erhöhte Jagderfolg bedeutet für die Steinadler im Untersuchungsgebiet 

eine gute Nahrungssituation und kann u.a. während der Nestlingszeit positiv entscheidend sein.  

 

Da aktuell etwa 16 % des Untersuchungsgebietes durch Almwirtschaft geprägt ist 

(WWW.NATIONALPARK.CO.AT), sind auch in tieferen Lagen offene Vegetationsabschnitte zu 

finden und stehen dem Steinadler als potentielle Jagdflächen zur Verfügung. Besonders viele 

Almflächen finden sich dabei im Bereich der Hochtorgruppe. Zu nennen ist z.B. die Sulzkaralm 

die Gamssteinalm und die Neuburgalm (vgl. ALPENVEREINSKARTE). Hinzu kommen ehemals 

genutzte Almflächen, die noch nicht wieder dicht bewaldet sind. Beispiel hierfür ist die Stadlalm 
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(vgl. ALPENVEREINSKARTE). Auf Grund des Vorhandenseins geeigneter Jagdgebiete über der 

Waldgrenze, stellen zusätzliche Almflächen für die Adler des Planungsgebietes keine 

Notwendigkeit dar, bedeuten aber eine Verbesserung der Bedingungen.  

 

Anhand der Höhenverteilung lässt sich für das Untersuchungsgebiet auch eine große 

Reliefenergie ableiten (vgl. A 2). Die Kombination von zunehmender Meereshöhe und größer 

werdenden Höhenunterschieden hat dabei einen positiven Einfluss auf die Lebensbedingungen 

des Steinadlers. Der bodengebundene anthropogene Einfluss nimmt im Allgemeinen deutlich ab 

und der Adler findet mehr ungestörte Lebensbereiche und Rückzugsmöglichkeiten (siehe Kapitel 

4.4).  

 

4.1.3 Expositionsverteilung 

Die Exposition spielt eine entscheidende Rolle für die Struktur eines Lebensraums, da mit ihr 

zahlreiche Faktoren wie Vegetation, lokale Temperaturen und Sonneneinstrahlung variieren. 

Nicht abgeschattete, südexponierte Flächen werden hauptsächlich während den Mittagsstunden 

beschienen, wenn die Sonne ihren Höchststand erreicht hat. Zu dieser Zeit wird auf der 

Bodenoberfläche am meisten Energie umgesetzt und führt zur tageszeitlich stärksten Erwärmung 

der darüber liegenden Luftschichten. Gerade in den Wintermonaten, wenn die Strahlkraft der 

Sonne gering ist und sich - bei zusätzlich schneebedeckter Landschaft - allgemein nur sehr 

schwache thermische Aufwinde entwickeln, bieten sich dem Steinadler in diesen Bereichen die 

besten Thermikbedingungen. Nach Studien von HALLER (1996) ist die winterliche Flugaktivität 

fast zu 85 % an südexponierte Sonnenhänge gebunden. Diese Aufwindgebiete und deren 

räumliche Vernetzung mit geeigneten Jagdgebieten sind deshalb ein wesentlicher Schlüsselfaktor 

für die Lebensraumeignung (BRENDEL et al. 2000). 

Weist ein Gebiet viele nach Süden ausgerichtete Hänge auf, wie das im Untersuchungsgebiet mit 

über 15 % Flächenanteil der Fall ist (siehe Abb.15), ergeben sich für den Steinadler im Winter 

verhältnismäßig gute Flugbedingungen. Auch die Expositionen Südost und Südwest sind im 

Gebiet stark vertreten (siehe Kapitel 3.1.3). Unter Einbezug des Umweltparameters 

„Einstrahlsituation am 21.12.04“ lässt sich erkennen, dass der größte Teil (12,21 %) dieser 

südexponierten Flächen zur Mittagszeit auch tatsächlich bestrahlt wird. Hinsichtlich der 

räumlichen Verteilung fällt auf, dass die südexponierten Hänge im Nordteil des 

Planungsgebietes einheitlicher verteilt sind als im Südteil (siehe Abb.15). Den Steinadlern ist 

somit nördlich der Enns eine optimalere Raumnutzung möglich.  
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Ein weiterer Vorteil der Südhänge liegt in dem dort schnelleren Abtauen des Schnees. Gämsen 

und Rauhfußhühner halten sich bei allgemeiner Schneebedeckung der Landschaft bevorzugt an 

diesen wärmeren, oftmals schon im Spätwinter ausapernden Flächen auf und suchen nach 

Nahrung oder erwärmen sich in der Sonne (BAUMANN et al. 2000, BEZZEL 1984, GLUTZ VON 

BLOTZHEIM 1971). Auch die sommeraktiven Murmeltiere bringen bezüglich ihres Lebensraumes 

eine große Präferenz gegenüber dieser Hangausrichtung auf (STUBBE 1988) und stehen dem 

Steinadler dort vermehrt zur Verfügung. Da die Südexposition mitbestimmend ist für die 

Aufenthaltswahrscheinlichkeit der Beutetiere, hat sie indirekt erneut einen Einfluss auf den 

Greifvogel. Geländenachweise im Planungsgebiet bestätigen diese Präferenzen von 

Murmeltieren und Gämsen jedoch nur bedingt (DATENGRUNDLAGE NATIONALPARK GESÄUSE 

GMBH). Grund hierfür ist u.a. die Verteilung der passenden Biotoptypen, die vermutlich von 

größerer Bedeutung für das Vorkommen dieser Beutetiere ist.  

Hinsichtlich der Südexposition unter Einbezug der Verteilung von Gams, Murmeltier und 

Birkwild, weist im Allgemeinen der Südteil des Planungsgebietes für den Steinadler bessere 

Bedingungen auf.  

Berechnen der Südeposition im GIS: 

 Exposition laden 

 Spatial Analyst > Raster Calculator > als Layer „Exposition“ wählen > Exposition Süd berechnen 

(Exposition = 6)  

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 
 

Wichtig für die tageszeitliche Raumnutzung und ebenfalls ein bestimmender Faktor für die 

Habitatqualität sind die Ost- und Südost- sowie die Südwest- und Westexpositionen (LINK 

1987). Die nach Ost und Südost ausgerichteten Hänge werden von der Morgensonne beschienen 

und vom Steinadler bevorzugt zwischen 7.00 - 11.00 Uhr aufgesucht (HALLER 1996). Die 

westlich exponierten Geländebereiche sind dagegen am Nachmittag besonnt und werden deshalb 

vornehmlich zwischen 11.00 - 19.00 Uhr genutzt (HALLER 1996). Telemetrienachweise eines 

Steinadlerweibchens im Nationalpark Berchtesgaden bestätigen diese expositionsabhängige 

Raumnutzung (EBERHARDT 1997). Da im Untersuchungsgebiet keine klare Revierabgrenzung 

bekannt ist, kann keine eindeutige Aussage hinsichtlich dieser Tatsache getroffen werden. 
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Abb. 15: Verteilung der Südexposition im Untersuchungsgebiet 
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Die in einigen Arbeiten erwähnte Präferenz für eine bestimmte Exposition bezüglich der 

Auswahl geeigneter Brutstandorte wird widerlegt bei dem Vergleich unterschiedlicher Studien 

miteinander (LANDMANN & MAYRHOFER 2001, HENNINGER et al. 1987, HALLER 1996).  Für 

weite Bereiche der Alpen ist jedoch keine signifikante Bevorzugung einer bestimmten 

Exposition gegeben und die Expositionsverteilungen weichen, entsprechend dem variierenden 

Angebot geeigneter Felswände, voneinander ab (HALLER 1996). Anhand bisheriger 

Horstnachweise im Untersuchungsgebiet (DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH) 

konnte ebenfalls keine dominierende Exposition festgestellt werden. 

 

4.1.4 Neigung 

Da die Hangneigung entscheidend dafür ist, in welchem Winkel die Sonneneinstrahlung auf der 

Bodenoberfläche auftrifft und in welchem Maße sie diese erwärmt, werden dadurch die für den 

Steinadler relevanten Thermikverhältnisse beeinflusst (BRENDEL et al. 2000). Das hauptsächlich  

mittel bis stark geneigte Gelände des Planungsgebietes ermöglicht bei flach einfallender 

Sonnenstrahlung eine bessere Energieumsetzung und somit stärkere Thermikentstehung 

(FLEMMING 1994). Im Winter und in den frühen Morgen- sowie späten Abendstunden bringt das 

für die Steinadler, vor allem in den hohen Gipfelbereichen, bessere Flugbedingungen mit sich. 

Südlich der Enns zieht sich – vom Admonter Reichenstein über den Großen Ödstein, das 

Hochtor, der Planspitze und weiter Richtung Nordost - ein Band steiler Hangpartien durch das 

Untersuchungsgebiet, weshalb sich in diesem Bereich gute Bedingungen bezüglich der 

Raumnutzung ergeben. Nördlich der Enns konzentrieren sich diese Flächen v.a. um den Großen 

Buchstein.   

Die vorhandenen, steilen Geländeabschnitte bringen für den Steinadler noch weitere Vorteile mit 

sich. Mit zunehmender Neigung des Geländes kann sich weniger Boden bilden sowie Vegetation 

ansiedeln. Bei diesen Gegebenheiten und einer entsprechenden Morphologie des Untergrunds – 

wie es im Planungsgebiet Nationalpark Gesäuse gegeben ist (GREIMLER 1993) - bieten sich dem 

Adler verhältnismäßig viele potentielle Brutstandorte (vgl. Kapitel 3.3.1).  

Stärkere Hangneigungswinkel ermöglichen zudem eine bessere Einsehbarkeit in die 

Waldbereiche - insbesondere in lichte Waldabschnitte - und verbessern damit die 

Jagdbedingungen (BÖGEL 1995, BRENDEL et al. 2000). Hierzu mehr in Kapitel 3.3.3. 

Hinzu kommt, dass die Steilheit des Untersuchungsraumes einen positiven Einfluss auf die 

Verteilung der Beutetiere hat. Z. B. suchen Schneehühner (BEZZEL 1984) und Gämsen 

(BAUMANN 2000) bei der Nahrungssuche in den Wintermonaten bevorzugt steilere und 

schneefreie Geländeabschnitte auf und können dort ideal vom Adler gejagt werden. Aber auch in 
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den Sommermonaten präferieren Gämsen Gelände mit einem Neigungswinkel zwischen 30° - 

50° (LOTZ 1997). Die Anwesenheit von Gämsen – auf Gelände mit diesen Eigenschaften - kann 

im Planungsgebiet bestätigt werden (DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH). Das 

Hauptverbreitungsgebiet liegt dabei v.a. südlich der Enns.  

Die mittel bis stark geneigte Landschaft im Untersuchungsgebiet begünstigt im Winter mehr 

Lawinenabgänge, die dem Steinadler Fallwild zur Verfügung stellen können (BRENDEL et al. 

2000). Siehe dazu Kapitel 3.3.2. 

 

4.1.5 Einstrahlsituation  

Die Reliefstruktur einer Landschaft hat einen entscheidenden Einfluss auf die verschiedenen 

Besonnungsverhältnisse. Ein stark reliefiertes Gelände – wie es im Untersuchungsgebiet 

vorkommt - verringert auf Grund der großen Abschattwirkung die Menge und Zeitdauer der 

einfallenden Sonneneinstrahlung meist erheblich. Lediglich die oberen Gipfelbereiche sind 

davon nicht betroffen und werden beschienen.  

Besonnte Areale bilden die Grundlage für die Entstehung von thermischen Aufwinden. Da diese 

von Bedeutung für den Steinadler sind (vgl. Kapitel 4.3.4), hat die Besonnungssituation vor 

allem im Winter einen wesentlichen Einfluss auf den Greifvogel (HALLER 1996). In dieser Zeit 

bestimmen die Sonnenflächen sehr stark den Aufenthalt der Beutetiere (vgl. Kapitel 4.1.3 und 

Kapitel 4.3.4).  

 

4.2    Auswirkung des biotischen Umweltfaktors auf die Lebensraumqualität 

Einen wesentlichen Aspekt für die Habitatwahl und deren Eignung als Lebensraum stellt die Art 

und räumliche Verteilung der Biotoptypen dar. Durch deren Eigenschaften wird vor allem die 

Verfügbarkeit der Nahrung bestimmt, aber auch andere Bedürfnisse wie das Vorhandensein von 

geeigneten Brutstandorten.  

Über die Hälfte des Untersuchungsraumes – vor allem der nördliche Bereich des 

Planungsgebietes  - ist von Wald dominiert (siehe Kapitel 3.2). Da der Steinadler in den Alpen 

seinen Primärlebensraum - neben alpinen Grasheiden - hauptsächlich in felsigen Schuttfluren, 

Blockhalden und Felswänden besitzt (BRENDEL 1998), lässt dies im Großteil des Gebietes auf 

keine optimalen Lebensbedingungen für den Greifvogel schließen. Flächen mit einer dichten 

Baumstruktur sind für den Steinadler auf Grund der schlechten Anflugmöglichkeit, der geringen 

Einsehbarkeit und der schwierigen Erreichbarkeit der Beute, weder als gute Brutstandorte noch 

als Jagdgebiete geeignet (EBERHARDT 1996). Etwas bessere Bedingungen bieten Laub- und 

Mischwälder, die wegen des Laubabfalls in den Wintermonaten mehr Sicht und Jagd auf die 
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Beutetiere ermöglichen. Jedoch machen diese Waldtypen nur ein 1/3 des Waldes im 

Planungsgebiet aus (siehe Kapitel 3.2). Der einzige Vorteil des stark ausgeprägten Waldgürtels 

liegt darin, dass dort bei allgemein schneebedeckter Landschaft trotzdem thermische Aufwinde 

entstehen (vgl. Kapitel 3.3.4). Im Sommer fordert der Wald hingegen wegen der hohen 

Verdunstungstätigkeit einen hohen Energieaufwand vom Adler, da sich über solchen Flächen nur 

eine abgeschwächte Thermik entwickeln kann (BÖGEL 1996).  

Der im Untersuchungsraum am zweitstärksten vorkommende Biotoptyp „Latschen“ (etwa 20 %) 

bietet dem Steinadler ebenfalls keine optimalen Lebensbedingungen, weder in Bezug auf die 

Brut- noch die Jagdmöglichkeiten. Auch wenn diese Krummholzzone hinsichtlich den 

Einsehbarkeits- bzw. den eigenen Deckungsmöglichkeiten gute Voraussetzungen für die Jagd 

aufweist, so halten sich in diesem Biotoptyp jedoch nur wenige Beutetiere des Steinadlers auf. 

Vereinzelt ist z.B. die Gams dort anzutreffen. Im Vergleich der Biotoptypenverteilung mit den 

Aufenthaltsgebieten der Gams im Planungsgebiet des Nationalparks Gesäuse wird das bestätigt 

(DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH). Die Latschenregion macht im 

Vorkommengebiet dieses Paarhufers jedoch nur einen sehr geringen Flächenanteil aus.    

Die als Primärlebensraum bezeichneten Biotoptypen „Fels“ und „Alpiner Rasen“ (BRENDEL 

1998) machen im Untersuchungsgebiet zusammen fast ¼ der Flächen aus. In felsigen 

Geländebereichen bieten sich dem Steinadler bestmögliche Nistmöglichkeiten (siehe Kapitel 

3.3.1) und im Bereich der Grate und Kanten findet er gute Jagdbedingungen für Gämsen und 

Alpenschneehühner (SIELMANN 1981). Zudem ermöglichen diese vegetationskargen, felsigen 

Areale eine perfekte Einsehbarkeit in das Gelände und eine gute Erreichbarkeit der Beute 

(EBERHARDT 1997). So wechselt das Gamswild bei zu starker Beunruhigung von den 

bevorzugten tiefer liegenden Regionen in die unzugänglichen Felsbereiche (STUBBE 1988). Ein 

weiterer Vorteil der Felsflächen ist deren sehr gute Bodenerwärmungsfähigkeit, weshalb sich 

hier auch die besten Thermikareale befinden.  

Alpine Rasen ermöglichen es ebenfalls nach den bevorzugten Strategien zu jagen und hohe 

Jagderfolge zu erzielen (BRENDEL et al. 2000). Zudem führen sie im Sommer zu einer sehr guten 

Thermikentwicklung (BRENDEL 1998).  

Zu finden sind die felsigen Bereiche hauptsächlich in den höheren Lagen der drei markanten 

Gebirgsstöcke des Untersuchungsgebietes. Dabei konzentrieren sich die Felsabschnitte am 

Admonter Reichenstein und am Großen Buchenstein lediglich in einem Areal um den Gipfel, 

wohingegen sie sich bei der Hochtorgruppe über mehrere, auch kleinflächigere Bereiche 

erstrecken. Letzteren Gebiet ist zudem stark mit Alpinem Rasen durchzogen (siehe Abb.8 und 

ALPENVEREINSKARTE) und überschneidet sich am meisten mit den Vorkommengebieten der 



4 Auswertung 

 

48

bevorzugten Beutetiere, weshalb der Landschaftsabschnitt zwischen Großem Ödstein – 

Planspitze – Stadelfeld als idealer Primärlebensraum bezeichnet werden kann. 

In Bezug auf die eigenen Deckungsmöglichkeiten während der Jagd, sind die Biotoptypen „Fels“ 

und „Alpiner Rasen“ für den Steinadler nicht optimal. Hier eignen sich am besten Flächen des 

Biotoptyps „Lichter Wald“ (EBERHARDT 1997) und „Lichter Steiler Wald“.  

Bei einer differenzierten Betrachtung der Biotoptypen fällt auf, dass fast 40 % des 

Untersuchungsraums als geeignete Jagdgebiete dienen können und die Lebensbedingungen für 

den Steinadler nicht so schlecht sind, wie auf Grund des hohen Wald- und Latschenanteils 

zunächst erwartet wurde. 

 

Die rein quantitativen Flächenangaben der einzelnen Biotoptypen erlauben jedoch nur bedingt 

eine Aussage. Nicht alle potentiell geeigneten Flächen werden in Wirklichkeit vom Steinadler 

genutzt, da zusätzliche Einflussfaktoren wie z. B. spezielle Nachbarschaftsverhältnisse, 

Störungen oder die räumliche Vernetzung der geeigneten Flächen deren Eignung beeinflusst.  

 

4.3    Auswirkung weiterer Faktoren auf die Lebensraumqualität 

4.3.1 Potentielle Brutfelsen 

In gebirgigen Regionen wie den Alpen, wo ein großes Angebot an felsigen Bereichen besteht 

und tragfähige Bäume mit entsprechendem Alter und Durchmesser oftmals fehlen, bevorzugt der 

Steinadler Fels- anstatt Baumhorste (vgl. BRENDEL et al. 2000). Auf Grund der Morphologie des 

Untergrundes (GREIMLER 1992) und der intensiven forstlichen Nutzung, die verantwortlich ist 

für den geringen Bestand alter, stabiler Bäume ist dies auch für das Planungsgebiet des 

Nationalparks Gesäuse anzunehmen. Bereits erhobene Horste belegen dies  

(DATENGRUNDLAGE NATIONALPARK GESÄUSE GMBH).  

Laut der Analyse befinden sich viele der potentiellen Brutfelsen in den oberen Bereichen der 

Bergstöcke zwischen 1.500 m – 1.900 m ü. A. Bisher entdeckte Horste im Untersuchungsgebiet 

weisen jedoch nur eine maximale Höhe von 1.400 m – 1.500 m ü. A auf (DATENGRUNDLAGE 

NATIONALPARK GESÄUSE GMBH). Grund hierfür ist die vergleichsweise geringere vertikale 

Höhenerstreckung der Landschaft im Planungsgebiet gegenüber weiteren Gebirgszügen in den 

Nördlichen Kalkalpen, welche die Grundlage für die Berechnungen bilden (siehe Kapitel 2.3.3). 

Der Steinadler legt seine Horste fast ausnahmslos unterhalb der Jagdgebiete an (siehe Kapitel 

2.3.3). Da potentiell geeignete Jagdareale im Planungsgebiet schwerpunktmäßig zwischen 1.500 

m – 1.900 m ü. A liegen - wie sich bei der Analyse der potentiell geeigneten Jagdgebiete unter 

Einbezug der Höhe erkennen lässt - findet der Steinadler nur dann ideale Bedingungen vor, wenn 



4 Auswertung 

 

49

die Nistplätze unterhalb dieser Höhenlage liegen. Die GIS-Analyse der potentiellen Brutfelsen, 

die sich auf einen Höhenbereich zwischen 800 m – 1900 m ü. A bezieht, ist im 

Untersuchungsgebiet deshalb nur bedingt aussagekräftig.  

Berechnung der potentiell geeigneten Jagdgebiete: 

 Biotoptypen und Berechnung „Lichter Wald“ laden 

 Spatial Analyst > Raster Calculator > als Layer „Biotoptypen“ wählen > Biotoptypen „Alpiner Rasen“ 

und „Fels“ und „Nadelwald licht“ berechnen (Biotoptyp = 6 or Biotoptyp = 7 or Biotoptyp =2) 

 diese Berechnung mit Berechnung „Lichter Wald“ addieren: Spatial Analyst > Raster Calculator > 

Berechnung + Berechnung „Lichter Wald“ > Evaluate  

 Darstellungsänderung der Berechnung: mit re Maustaste auf Layer > Properties (Namensänderung unter 

“General“, Farbänderung unter „Symbology“) 

 

Es ist darauf hinzuweisen, dass sich auf Grund der Auflösung des Digitalen Geländemodells und 

der Luftbildklassifikation Ungenauigkeiten gegenüber der Realität ergeben können. Felsbereiche 

wurden nur dann erfasst, wenn sie einen größeren Raumausschnitt einnehmen (vgl. Kapitel 2.2). 

Nach HALLER (1982) und GLUTZ VON BLOTZHEIM (1971) können Horstwände - vorausgesetzt 

sie ermöglichen einen guten Anflug – auch nur 10 m hoch und vollständig von Wald umgeben 

sein. Kleine Felswände wie diese konnten in der vorliegenden Analyse nicht erfasst werden. 

 

Hinsichtlich der räumlichen Verteilung von potentiell geeigneten Brut- und Jagdgebieten fällt 

auf, dass diese sich verstärkt um die Gebirgsstöcke konzentrieren (vgl. Abb.16). V.a. im Bereich 

der Hochtorgruppe bietet sich dem dort angesiedelten Steinadlerpaar die Möglichkeit zwischen 

verschiedenen Jagdgebieten und Nistplätzen zu wechseln und somit eine ideale räumliche Lage 

zueinander zu wählen. Jedoch ist auch in anderen Bereichen eine Anlage von Wechselhorsten 

möglich. Da die Lage der Brut- und Jagdgebiete zueinander einen entscheidenden 

Schlüsselfaktor darstellt (BRENDEL et al. 2000), finden die Steinadler diesbezüglich im 

Untersuchungsgebiet gute Lebensbedingungen vor.  
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Abb. 16: Lage der potentiellen Brutfelsen zu den potentiell geeigneten Jagdgebieten im Untersuchungsgebiet  
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4.3.2 Potentielle Lawinenareale 

Im Winter, wenn die Jagdbedingungen sehr hart sind, ernährt sich der Steinadler teilweise zu 

über 50 % von Fallwild (GLUTZ VON BLOTZHEIM 1971, LANDMANN & MAYRHOFER 2001, LINK 

1987). Die in Lawinen verunglückten Tiere apern meist im Spätwinter bis Frühjahr in den tiefer 

liegenden Gebieten aus und stehen dem Adler dann als Nahrung zur Verfügung. Milde Winter 

oder Gebiete, in denen kaum Lawinen abgehen bzw. sich keine Tiere aufhalten, stellen dem 

Adler kaum Aas zur Verfügung und können sogar als limitierende Faktoren angesehen werden 

(KLUTH & BEZZEL 1999). Für das Planungsgebiet des Nationalparks Gesäuse trifft dies nicht zu. 

So sind dort meist schneereiche Winter zu verzeichnen (GREIMLER 1997) und potentielle 

Lawinenareale sind recht einheitlich im Bereich der drei markanten Gebirgsgruppen des 

Untersuchungsgebietes zu finden. Auch unter Einbezug der Tatsache, dass Lawinen v.a. an 

nordexponierten Hängen abgehen (http://wa.slf.ch/unfaelle/LawRisikoBulletin.pdf), trifft dies 

zu. So weisen fast 1/3 der berechneten potentiellen Lawinenareale eine nördliche Exposition auf. 

Das Vorkommen von Tieren ist in den potentiellen Lawinengebieten ebenso gegeben, wie die 

Datengrundlagen des Nationalparks Gesäuse für den Winterlebensraum der Gams erkennen 

lassen. Hauptsächlich im südlichen und östlichen Bereich der Hochtorgruppe ist die 

Wahrscheinlichkeit für Gamsfallwild sehr groß.  

Die Wahrscheinlichkeit, dass Lawinen in einer Waldzone auslaufen und das Fallwild für den 

Adler wegen der dortigen geringen Einsehbarkeit nur schwer erreichbar ist, relativiert die gute 

winterliche Nahrungssituation.  

Ein starkes Vorkommen an Lawinen bzw. Tieren und damit eine größere Fallwilddichte, locken 

Einzeladler an (BRENDEL & D`OLEIRE-OLTMANNS 1996). Diese dringen oft in fremde Reviere 

ein und stellen für die dort angesiedelten Steinadlerpaare - vor allem für den Zeitraum 

Spätwinter - Frühjahr, wenn diese Greifvögel mit dem Brutgeschäft beginnen - einen 

zusätzlichen Stressfaktor dar. Für das Untersuchungsgebiet sind hierzu keine detaillierten 

Aussagen bekannt. Auf Grund der Lage im Randverbreitungsgebiet ist diesbezüglich von keiner 

großen, negativen Beeinflussung auszugehen.  

Der Anteil an potentiellen Lawinenarealen erlaubt nur begrenzt eine Aussage über die 

tatsächliche winterliche Nahrungssituation und die daraus resultierenden 

Lebensraumverhältnisse. So spielt z.B. auch das tatsächliche Vorhandensein von Schnee, ein 

lawinenauslösender Schneedeckenaufbau oder förderliche Windverwehungen eine entscheidende 

Rolle. Starke touristische Einflüsse oder hohe Abschusszahlen können die guten 

Fallwildverhältnisse ebenfalls relativieren.  
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4.3.3 Einsehbarkeit in das Gelände 

Wie die Analysen der Höhenverteilung, Biotoptypen, der potentiellen Lawinenareale und das 

Beutetiervorkommen erkennen lassen, sind im Untersuchungsgebiet günstige Voraussetzungen 

bezüglich einer guten Nahrungssituation für den Steinadler gegeben. Da der Greifvogel häufig 

sein Revier im Suchflug durchstreift und seine Beute bzw. das Fallwild optisch ausmacht, 

spielen auch die Einsehbarkeit in das Gelände und eigene Deckungsmöglichkeiten eine wichtige 

Rolle (BRENDEL et al. 2000). Neben der Thermik, ist diese Erreichbarkeit und Verfügbarkeit der 

Beute gerade in den Wintermonaten von entscheidender Bedeutung und mitbestimmend für eine 

erfolgreiche nächste Brutsaison (BRENDEL et al. 2000). Auch wenn im Planungsgebiet der 

Biotoptyp „Wald“ dominiert, so ist ganzjährig in über der Hälfte des Gebietes eine mittlere bis 

hohe Einsehbarkeit gewährleistet. Begründet wird dies - neben den Latschen, Alpinen Rasen und 

Felsen - durch den verhältnismäßig großen Anteil an lichtem Wald (siehe Abb.12). Für den 

Steinadler ergeben sich dadurch gute Jagdbedingungen im Untersuchungsgebiet. Gerade die 

lichten Waldabschnitte sind von besonderer Bedeutung und eigenen sich für diesen Greifvogel 

ideal zur Jagd. Neben der Einsehbarkeit ist auf diesen Flächen zudem eine sehr gute eigene 

Deckungsmöglichkeit gewährleistet und die Steinadler können dort optimal ihre 

Überraschungstaktik anwenden (EBERHARDT 1996).  

Allgemein kann der Südteil des Planungsgebietes hinsichtlich der Einsehbarkeitsverhältnisse für 

den Steinadler als besser geeignet bewertet werden, auch wenn sich die Situation in den 

Wintermonaten etwas relativiert. Gebiete mit geringer Einsehbarkeit konzentrieren sich dagegen 

hauptsächlich im nördlichen Teil des Untersuchungsraums (vgl. Abb.11) und bieten den dort 

angesiedelten Adlern schlechtere Jagdbedingungen. So finden die Beutetiere in den dichten und 

weniger einsehbaren Vegetationsstrukturen einen guten Schutz vor Angriffen aus der Luft und 

sind für den Adler nicht bzw. nur schlecht erreichbar. 

 

4.3.4 Thermik 

Auf Grund seines relativ hohen Gewichts und spezieller Jagdstrategien ist die Thermik von 

wesentlicher Bedeutung für den Steinadler (HALLER 1982, JENNY 1992, LINK 1987). Starke 

thermische Strömungen ermöglichen ihm einen schnellen und energiesparenden Höhengewinn 

durch Aufkreisen, so dass er dann in Form von Gleit- bzw. Streckenflügen größere Distanzen 

zurücklegen und seine Jagd- und Brutgebiete aufsuchen kann (BRENDEL et al. 2000, HALLER 

1996). Vor allem bei schneebedeckter Landschaft, wenn thermische Aufwinde nur in äußerst 

geringem Maße auftreten und der Steinadler auf Grund der Nahrungsknappheit versuchen muss 



4 Auswertung 

 

53

seinen Energieverbrauch zu minimieren (GAASCH 2002), sind schneefreie Gebiete, die eine 

Thermikentwicklung ermöglichen von sehr großer Bedeutung.  

Neben den Flächenanteilen und der Intensität spielt auch die räumliche Verteilung dieser 

Aufwindgebiete eine entscheidende Rolle für die Lebensraumeignung (EBERHARDT 1996). 

Dieser Betrachtung sind jedoch Grenzen gesetzt, da die entstehenden Thermikschläuche mit 

zunehmender Höhe und der dort höheren Windgeschwindigkeit horizontal verlagert werden 

können. Somit kann nur der Entstehungsort der Aufwinde angezeigt werden, nicht aber wie sich 

die Situation in der Flughöhe des Adlers verhält (EBERHARDT 1996).  

 

Die Wärmekapazität des Waldes schafft relativ gleichmäßige thermische Aufwinde über den 

ganzen Tag hinweg (vgl. FLEMMING 1994), weshalb die Adler fast im gesamten 

Untersuchungsgebiet eine Thermik vorfinden, wenn auch nur eine schwache. Von größerer 

Bedeutung für den Steinadler sind jedoch Flächen mit einer guten bzw. sehr guten 

Thermikentstehung. Diese sind hauptsächlich im Bereich der Hochtorgruppe, um das 

Buchsteinmassiv und ein wenig am Tamischbachturm sowie am Admonter Reichenstein zu 

finden. Auf Grund der Großflächigkeit dieser guten Thermikgebiete hebt sich der Südteil des 

Planungsgebietes besonders positiv hervor (vgl. Abb.14). 

 

Bei schneebedeckter Landschaft lässt sich hinsichtlich der Thermikentstehung und den damit 

verbundenen besseren Flugbedingungen kein klarer Vorteil eines bestimmten Gebietsabschnittes 

erkennen. Die Verteilung der Biotoptypen sowie die große Abschattung durch die Gebirgsstöcke 

führen dazu, dass die Steinadler lediglich in den besonders steilen - jedoch kleinflächigen - 

Felsbereichen am Hochtor und am Buchstein sehr starke thermische Aufwinde vorfinden. Über 

diesen Arealen kann der Greifvogel schneller an Höhe gewinnen als über den großflächigeren, 

aber weniger starken Thermikflächen, weshalb diese Gebiete besonders hochwertig sind. Sie 

können den Kern der Aktionsräume bzw. bedeutende „Trittsteine“ hinsichtlich der Raumnutzung 

darstellen und die dortige Habitatqualität erheblich verbessern (BRENDEL et al. 2002). 

Hinzu kommt die dortige Vielzahl von kleineren Graten und Kanten, die vom Wind schnell 

schneefrei geweht werden (DEUTSCHER ALPENVEREIN 1989) und ebenso zu einer 

Thermikentstehung führen. 
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4.4   Bodengebundenes, anthropogenes Störpotential 

Die einzigartige Landschaft im Planungsgebiet des Nationalparks Gesäuse macht die Region seit 

vielen Jahren zu einem begehrten Ziel für Touristen. Da das Gebiet zudem über ein gut 

ausgebautes Wanderwegenetz und durch Forststraßen erschlossen ist sowie viele Hütten und 

Almen aufweist, bieten sich sehr gute Voraussetzungen für eine intensive touristische Nutzung. 

Zu nennen sind Freizeitaktivitäten wie Wandern, Klettern, Mountainbiken oder Skitouren- und 

Schneeschuhgehen. Vor allem im Bereich der offenen Landschaftsabschnitte – den potentiellen 

Jagdgebieten des Steinadlers - haben diese einen negativen Einfluss auf das Raum-Zeitmuster 

der Beutetiere, wodurch diese für den Steinadler eingeschränkt nutzbar werden (BUND 

NATURSCHUTZ IN BAYERN e. V. 1999, GEORGII 2001). Entweder die Tiere verlassen die offenen 

und ungeschützten Bereiche vorzeitig, suchen diese Orte für längere Zeit nicht mehr auf oder sie 

wandern bei dauerhafter Störung ganz aus dem Gebiet ab. Es gibt auch Hinweise auf einen 

Zusammenhang zwischen der Belastung von Steinadlerrevieren durch bodengebundene 

Freizeitaktivitäten und einem negativen Bruterfolg (BAYERISCHES STAATSMINISTERIUM FÜR 

LANDESENTWICKLUNG UND UMWELTFRAGEN 2002). 

 

Eindeutige Aussagen bezüglich der bodengebundenen anthropogenen Störung und der 

Auswirkung auf den Steinadler und dessen Beutetiere sind schwer zu treffen. So wirkt nicht jede 

Störung mit gleicher Intensität auf die Tiere und jede einzelne Situation ist abhängig von 

verschiedenen Faktoren. Zu nennen sind z.B. Ort, Richtung und Geschwindigkeit der 

Annäherung durch den Menschen, der Tages- und Jahresverlauf, die Position der Störquelle zu 

den Tieren, die Intensität des akustischen Ereignisses, die farbliche Beeinflussung, der Abstand 

zum Rückzugsgebiet (vgl. INGOLD 2005). 

Diese Faktoren werden in der vorliegenden Arbeit nicht berücksichtigt. Im Vordergrund stehen 

die Fragen: Von welcher Art ist die bodengebundene anthropogene Störung? Wie sieht die 

räumliche Verteilung der Gebiete mit potentieller Störung aus und in welchen Bereichen ist 

deshalb mit einem negativen Einfluss auf den Steinadler und seine Beutetiere zu rechnen?  

 

Störungen bewirken bei Wildtieren unterschiedliche Reaktionen wie z.B. Aufmerken, Sichern, 

Flucht oder ein „sich drücken“ (INGOLD 2005). In Bezug auf die Verfügbarkeit der Beutetiere für 

den Steinadler ist nicht das Aufmerken sondern lediglich das Flucht- und Deckverhalten von 

Bedeutung. Diese Art der Reaktion bewirkt, dass sich die Tiere in geschützte Bereiche 

zurückziehen und dem Adler nicht mehr als Beute zur Verfügung stehen.  
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Für die Berechnungen der vorliegenden Arbeit wurde ganzjährig von folgenden Fluchtdistanzen 

der Tiere ausgegangen (vgl. INGOLD 2005): 

 Gams : maximale Fluchtdistanz von etwa 200 m  

 Murmeltier: maximale Fluchtdistanz von etwa 50 m 

 Birk- und Schneehuhn: maximale Fluchtdistanz von etwa 100 m 

 

4.4.1    Störquelle im  Sommer 

Die bodengebundene anthropogene Störung ist während der Sommermonate fast ausschließlich 

im Bereich des Wegenetzes zu verzeichnen (SCHREB 2005), zu dem v.a. die ganzjährig genutzte 

Bahnstrecke und Bundesstrasse in den Talabschnitten, Forststrassen, die Wanderwege sowie die 

Kletterzustiege zählen. Grund hierfür ist die großteils sehr unzugängliche und steile Landschaft, 

die eine Geländebegehung oder -nutzung abseits der markierten Wege und Strassen erheblich 

einschränkt. Auch der Zugang zu alpinen Kletterrouten ist nur auf vorgegebenen Steigen 

möglich.  

Freizeitaktivitäten im Bereich der Enns wurden nicht eingehender berücksichtigt, da diese 

Abschnitte nicht zum Primärlebensraum des Steinadlers und seiner bevorzugten Beutetiere 

zählen (BRENDEL et al. 2000).  

 
Berechnen der bodengebundenen anthropogenen Störung für die Sommermonate im GIS: 

 Shape-files „Wanderwege“, „Strassen“, „Bahn“ und „Kletterzustieg“ laden 

 Weitere Arbeitschritte sind  nur mit Polygon-shape-files möglich, weshalb alle Linien-shape-files zunächst 

in Polygon-shape-files umgewandelt werden müssen. Dazu wird um jedes shape-file jeweils ein Puffer von 

1 m gelegt: ArcToolbox öffnen > Analysis Tools > Proximity > Buffer (Input Feature wählen, Distance = 

Linear Unit 1 meters) > ok 

 Einzelne Buffer- shape-files zu einem einzigen shape-file  „Wegenetz_Störung“ zusammenfügen:   

 ArcToolbox öffnen > Analysis Tools > Overlay >Union (2 Input Features wählen) > ok 

 diesen Arbeitsschritt so lange ausführen bis alle shape-files zusammengeführt wurden 

 Berechnung der unterschiedlichen Distanzen zur Störquelle:  

 ArcToolbox öffnen > Spatial Analyst Tools > Proximity > Multiple Ring Buffer (Input Feature 

“Skitouren_Störung” wählen; Output Feature “bodengebundene_Störung_Sommer” festlegen;  Distances 

= 50, 100, 200; Buffer Unit = meters) > ok 

 Um die Flächen herauszufinden, wo sich die pot.geeigneten Jagdgebiete mit der bodengebundenen Störung 

überlagern, muss zunächst das shape-file „bodengebunden_Störung_Sommer“ in ein Rasterformat 

umgewandelt werden: 
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 Spatial Analyst > Convert > Feature to Raster (Inputfeature = „bodengebundene_Störung_Sommer“, 

Output Cell Size = 10) > ok 

 Anschließend Raster “bodengebunden_Störung_Sommer” mit Raster “pot. geeignete Jagdflächen“ 

überlagern: 

 Spatial Analyst > Raster Calculator ( „bodengebunden_Störung_Sommer“ * „pot. geeignete 

Jagdflächen“) > ok 

 

Bei einer differenzierten Betrachtung des Wegenetzes fällt folgendes auf: 

Die menschliche Besiedelung sowie die ganzjährig stark frequentierte Bahnstrecke und 

Bundesstrasse führen in den Talräumen zu großen Störungen, weshalb diese Bereiche als 

Lebensraum für den Steinadler generell nicht geeignet sind. Von den Forststrassen geht in Bezug 

auf den Adler nur ein geringes Störpotential aus, da diese hauptsächlich im Wald verlaufen und 

sich lediglich in wenigen Bereichen mit dem Primärlebensraum dieses Greifvogels 

überschneiden. Die größte Störung ist im Bereich der Wanderwege zu sehen. So stellt das 

Bergwandern in der Zeit zwischen Mitte/Ende Mai bis Oktober die bedeutendste Erholungsform 

in der Region dar und das Wanderwegenetz überlagert sich in vielen Bereichen mit potentiell 

geeigneten Jagdgebieten.  

Laut den Analysen der bodengebundenen anthropogenen Störung, ist im Sommer fast die Hälfte 

der potentiell geeigneten Jagdgebiete mehr oder weniger stark durch den Menschen beeinflusst 

(siehe Abb. 17). Vor allem im Bereich der Hochtorgruppe um die Heßhütte sind wichtige 

Nahrungs- und Vorkommengebiete der bevorzugten Beutetiere wie Gams, Murmeltier und 

Birkwild durch Wanderwege zerschnitten und den dort starken Erholungsbetrieb gestört. In 

diesen Regionen kann es deshalb zu einer Veränderung der Raumnutzung und des 

Aktivitätsrhythmus der Tiere kommen und die Nutzbarkeit dieser Jagdgebiete ist im Sommer für 

den Steinadler großteils sehr eingeschränkt.  

Auch im Bereich des Großen Buchsteins und des Lugauers sind größere Störeinflüsse zu 

verzeichnen. Das dortige Störpotential ist auf Grund der schwach frequentierten Wegenutzung 

jedoch nicht so hoch einzustufen wie im Bereich der Heßhütte (vgl. Abb.18).  

Die größten, ungestörten und potentiell geeigneten Jagdgebiete, die zudem das bevorzugte 

Beutetierspektrum aufweisen und somit optimale Jagdflächen für den Steinadler darstellen, sind 

um die Stadelfeldschneid zu finden. Des Weiteren kommen kleinflächigere Areale an den 

südöstlichen Hängen des Großen Buchsteins, des Tamischbachturms und des Reichensteins vor. 

Bei zukünftigen Managementmaßnahmen sollte diesen gebieten eine besondere Aufmerksamkeit 

zukommen. 
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Abb. 18: Häufigkeit der Wege- und Strassennutzung während der Sommermonate im Untersuchungsgebiet 
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4.4.2    Störquelle im Winter 

Das gesamte Planungsgebiet des Nationalparks Gesäuse ist ein klassisches und beliebtes 

Skitourensziel und die Zahl der Aktiven in dieser Region steigt zunehmend (SCHREB 2002). In 

den Wintermonaten ist die bodengebundene anthropogene Störung somit hauptsächlich im 

Bereich der Skitourenaufstiegs- und abfahrtsrouten zu verzeichnen (SCHREB 2005).  

 
Berechnen der bodengebundenen anthropogenen Störung für die Wintermonate im GIS:  

 Shape-files „Skitourenaufstiege“ und „Skitourenabfahrten“ laden 

 Einzelne  shape-files zu einem einzigen shape-file  „Skitouren_Störung“ zusammenfügen:   

 ArcToolbox öffnen > Analysis Tools > Overlay >Union (2 Input Features wählen) > ok 

 Berechnung der unterschiedlichen Distanzen zur Störquelle: ArcToolbox öffnen > Spatial Analyst Tools > 

Proximity > Multiple Ring Buffer (Input Feature “Skitouren_Störung” wählen; Output Feature 

“bodengebundene_Störung_Winter” festlegen;  Distances = 50, 100, 200; Buffer Unit = meters) > ok 

 Um die Überlagerung von pot.geeigneten Jagdgebiete mit der bodengebundenen Störung zu berechnen, 

muss zunächst das shape-file „bodengebunden_Störung_Winter“ in ein Rasterformat umgewandelt 

werden: 

 Spatial Analyst > Convert > Feature to Raster (Inputfeature = „bodengebundene_Störung_Winter“, 

Output Cell Size = 10) > ok 

 Anschließend Raster “bodengebundene_Störung_Winter” mit Raster “pot. geeignete Jagdflächen“ 

überlagern: 

 Spatial Analyst > Raster Calculator („bodengebundene_Störung_Winter“ * „pot. geeignete Jagdflächen“) 

> ok 

 

Im Winter sind etwa 2/5 der potentiell geeigneten Jagdgebiete durch die Skitourenaktivität 

negativ beeinflusst (vgl. Abb.19). Die größten Überschneidungen zwischen wichtigen 

Lebensräumen des Steinadlers und Störzonen finden sich im südlichen Abschnitt des 

Planungsgebietes Richtung Hochtor, der Stadelfeldschneid und des Lugauers, aber auch im 

nördlichen Teil am Tamischbachturm. Unter Einbezug der Frequentierung hebt sich der Bereich 

zwischen Neuburgalm und Stadelfeldschneid besonders negativ hervor (vgl. Abb.20). Dieser 

Landschaftsabschnitt, der im Sommer die ungestörtesten Jagdbedingungen bietet, erfährt im 

Winter am meisten Störung. Mit großer Wahrscheinlichkeit sind die in dieser Region 

angesiedelten Steinadler deshalb zu einem jahreszeitlichen Wechsel ihres Jagdgebietes 

gezwungen. 
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Abb.19: Bodengebundenes anthropogenes Störpotential während der Wintermonate im Untersuchungsgebiet 
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Abb. 20: Frequentierung der Skitourengebiete während der Wintermonate im Untersuchungsgebiet
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5 Fazit  

Die in Kapitel 3 dargestellten und in Kapitel 4 diskutierten Ergebnisse verdeutlichen, dass das 

Untersuchungsgebiet dem Steinadler hinsichtlich der naturräumlichen Ausstattung als geeigneter 

Lebensraum dienen kann. Seine dortige Ansiedelung bestätigt dies (DATENGRUNDLAGE 

NATIONALPARK GESÄUSE GMBH, ZECHNER 2005). 

Von den natürlichen Gegebenheiten bietet der Südteil des Planungsgebietes dem Adler deutlich 

bessere Voraussetzungen als der Nordteil. Beispiel hierfür ist der hohe Anteil an frei bejagbaren 

Flächen über der Waldgrenze, die Einsehbarkeitssituation, die Thermikbedingungen im Sommer, 

das dortige Vorkommen der bevorzugten Beutetiere sowie die potentielle Lawinen bzw. 

Fallwildsituation. Der Bereich südlich und südöstlich des Hochtores könnte dabei ein ideales 

Revierzentrum darstellen. Unter Einbezug der bodengebundenen anthropogenen Störung 

relativiert sich jedoch diese Aussage, da gerade der Südteil und die als Revierzentrum geeigneten 

Bereiche ganzjährig erhebliche Störungen aufweisen. 
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Anhang 

Koordinaten für das Untersuchungsgebiet: 
Länge: 14° 26` 60`` 
Breite: 47° 34` 0`` 
 
 

A 1: Sonnenstandhöhe und Azimuthwerte für das Untersuchungsgebiet 

Jahreszeit Uhrzeit Höhe Azimuth
8 Uhr 26,2 83,06
12 Uhr 62,83 145,93
16 Uhr 47,86 251,1
20 Uhr 8,4 295,78

8 Uhr 1,25 127,16
12 Uhr 19,26 179,7
16 Uhr 1,56 232,39
20 Uhr 0 0

Sommer

Winter

 
 
 
 
 

A 2: Höhenklassen im Untersuchungsgebiet 

in km2 in %

    0 - 500 0,10 0,08
501 - 600 4,42 3,54
601 - 700 7,66 6,13
701 - 800 7,76 6,21

801 - 900 8,27 6,62
  901 - 1.000 9,21 7,37
1.001 - 1.100 9,47 7,58
1.101 - 1.200 9,33 7,46
1.201 - 1.300 8,69 6,95
1.301 - 1.400 9,59 7,67
1.401 - 1.500 10,76 8,61
1.501 - 1.600 10,63 8,50
1.601 - 1.700 8,90 7,12
1.701 - 1.800 7,26 5,81
1.801 - 1.900 4,90 3,92
1.901 - 2.000 3,67 2,94
2.001 - 2.100 2,70 2,16
2.101 - 2.200 1,26 1,01
2.201 - 2.300 0,34 0,28
2.301 - 2.400 0,04 0,03

Flächenanteil 
Höhenklassen in m ü. A
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A 3: Expositionsklassen im Untersuchungsgebiet 

in km2 in %
Flach 0,01 0,01
Nord 17,22 13,78
Nordost 11,95 9,57
Ost 13,55 10,85
Südost 19,59 15,67
Süd 19,37 15,50
Südwest 14,09 11,27
West 12,21 9,77
Nordwest 16,99 13,60

Exposition
Flächenanteil 

 
 
 
 
 

A 4: Neigungsklassen im Untersuchungsgebiet 

in km2 in %
  0 - 10 6,25 5,00
10 - 20 14,09 11,28
20 - 30 24,95 19,96

30 - 40 34,72 27,78
40 - 50 23,82 19,06
50 - 60 13,10 10,48
60 - 70 6,22 4,98
70 - 80 1,76 1,40
80 - 90 0,07 0,06

Neigung in °Grad
Flächenanteil 

 
 
 

 
A 5: Einstrahlverhältnisse während der Sommermonate im Untersuchungsgebiet 

Uhrzeit Sonnenflächenanteil in % Schattenflächenanteil in %
8 Uhr 64,56 35,44

12 Uhr 96,54 3,46
16 Uhr 91,64 8,36

20 Uhr 21,50 78,50  
 

 

A 6: Einstrahlverhältnisse während der Sommermonate im Untersuchungsgebiet 

Uhrzeit Sonnenflächenanteil in % Schattenflächenanteil in %
8 Uhr 7,81 92,19

12 Uhr 44,86 55,13
16 Uhr 6,45 93,54  
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A 7: Biotoptypenverteilung im Untersuchungsgebiet 

in km2 in %
Nadelwald dicht 32,22 25,78
Nadelwald licht 16,37 13,10
Mischwald 14,06 11,25
Laubwald 3,72 2,98
Latschen 24,95 19,96
Alp.Rasen / Magerr. /Wiesen / 
Hochst. / Sauerböden 9,79 7,84
Fels / Steinschutt / Kies 20,32 16,26
Moor 0,06 0,05
Versiegelte Flächen 0,31 0,24
Nicht definiert 3,18 2,54

Biotoptyp
Flächenanteil

 
 

 

 

A 8: Einsehbarkeitsverhältnisse während der Sommermonate 

 im Untersuchungsgebiet 

in km2 in %
Nicht definiert 3,18 2,54

30 50,00 40,01
50 16,37 13,10
60 25,25 20,20
100 30,18 24,14

Einsehbarkeit in % Flächenanteil 

 
 

 

A 9: Einsehbarkeitsverhältnisse während der Wintermonate 

 im Untersuchungsgebiet 

in km2 in %
Nicht definiert 3,18 2,54

30 32,22 25,78
50 30,43 24,35
60 28,97 23,18
100 30,18 24,14

Flächenanteil Einsehbarkeit in %
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A 10: Thermiksituation während der Sommermonate im Untersuchungsgebiet 

in km2 in %
0 4,33 3,46
10 0,06 0,05
20 0,00 0,00
30 0,00 0,00
40 0,00 0,00
50 33,51 26,82

60 55,90 44,73
70 0,00 0,00
80 9,72 7,78
90 0,00 0,00
100 18,57 14,85

Nicht definiert 2,88 2,30

Flächenanteil 
Thermikpotential in %

 
 

 

 

 

A 11: Thermiksituation während der Wintermonate im Untersuchungsgebiet 

in km2 in %
0 68,86 55,10
10 11,02 8,82
20 0,00 0,00
30 40,41 32,34
40 0,00 0,00
50 0,00 0,00

60 0,00 0,00
70 0,00 0,00
80 0,61 0,49
90 0,00 0,00
100 2,63 2,10

Nicht definiert 0,97 0,77

Thermikpotential in %
Flächenanteil 

 
 
 
 


